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      PREFACE
This is a practical beginners learning guide and reference book to Revit® for professionals and 
students of the building business. The approach presented is relevant to present or future pro-
fessionals involved in the building design process; architects and constructing architects in par-
ticular.
‘Revit - BIM and Concept Design’ consists of two volumes, of which this is Volume II.  Before 
starting using this volume, It is assumed that the user has worked through Volume I or achieved 
Revit knowledge and skills at a correponding level in other ways.
In essence, the two volumes together are an update to the book ‘Revit 2018 - BIM and Concept 
Design’ by the same authors.
Readers already familiar with the concept of the book can skip the rest of this preface.

Throughout the book, the learning process revolves around a case study project; a detached 
single family house in a rural setting. Like in the real world, changes are brought into the project 
in the course of the process. To support an even (but steep) learning curve, the development of 
the project goes from a simple design to one of intermediate complexity.
Volume I demonstrates and trains the most important basic procedures of modeling and docu-
mentation used in Revit. At the stage of finishing Volume I, the learner will be ready to apply the 
acquired skills on a basic level in a professional or educational context.
In Vokume II, the learner will be working with concepts and chains of commands of gradually 
increasing complexity.

The point of departure in developing the book and their predecessors was to supply students of 
Architectural Technology at VIA University Centre in Aarhus, Denmark a base for learning Revit. 
The book and its case study also form the base of courses of supplementary and in-service 
training arranged by VIA University College.

This book being an introduction to Revit for beginners, the case sets out at an early design stage, 
parallel to (but not in detail identical to) Stage 2: Concept Design as defined by RIBA of the UK, 
or Dispositionsforslag (Outline Proposal) as defined by Danske Arkitektvirksomheder and FRI 
of Denmark.

Besides its primary aim - to support learners in forming solid basic Revit skills - this book also 
seeks to serve as a guide to establishing a meaningful working process. Meaningful to be under-
stood in several ways:

 - Revit is a CAD-programme supporting BIM (Building Information Modeling). To benefit from 
this, so should our way of using it be.
Driven by legislation in many countries, BIM has become more than a theory of facilitating a 
smooth information flow and increasing the productivity in the building business, but a practical 
reality. This reality is still quite new and in rapid change, but with ‘best practices’ slowly emerg-
ing, however ambiguously. This book gauges the present state-of-the-art and suggests a robust 
model for the early stages of the building design process supporting BIM-method also in the later 
stages.

 - At the early stages of building design, an open and smooth method is vital to eventually arriv-
ing at a well-designed building proposal. However, in order to efficiently support BIM, Revit is a 
heavily parametric tool with few of the ‘light’ qualities of e.g. pencil drawing or other more intuitive 
computer tools. Therefore, the case study assumes an initial draft design being present before 
‘going BIM’ in Revit1.

1	 Another possible scenario is a Revit mass model being present at the starting point of this case study. Mass modeling 
is beyond the scope of this book.

I
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A smooth working method open to new ideas or changes of conditions is however at the core of 
BIM thinking. This book attempts to establish a practice of exploiting the BIM-potential of Revit 
by modeling with this in mind: Future project changes should be easy - whenever this can be 
achieved with little or even no extra effort.

In setting up Revit and preparing for modeling, this book suggests using a template based on 
DanEDU, an open source setup supplied and maintained by BIMlab at DTU (Technical Univer-
sity of Denmark). To get the full advantage of the instructions of this book, the user is advised to 
install the setup on the computer first.
The template is available for free at www.bimbogen.dk, the website of the publisher. To meet 
some didactical requirements of the book, and to keep the maintenance of the book at a mini-
mum, the template is a slightly modified version of the original DanEDU template. All modifica-
tions are made by the authors.

About the authors
Niels Ole Christiansen is a constructing architect MAK, BA in Architectural Technology and 
Construction Management from VIA University College in Horsens, Denmark. 
Through working in architectural offices and among contractors, he has gained extensive expe-
rience and for the last 17 years as self-employed in own practice. He has also experience as an 
instructor at an Autodesk Authorized Training Center.

Ask Raun is a MA in architecture with a degree from Aarhus School of Architecture. 
Through working in offices in London, UK and Aarhus, Denmark, and through his own practice, 
he has architectural experience in all project stages, from sketch proposals and competitions to 
being a project architect and a site supervisor.
Also, he has been teaching architecture and BIM at Aarhus TECH and VIA University College 
(present), and at Aarhus School of Architecture.
Through his practical and educational experience, he has established a practical knowledge as 
well as a theoretical interest in the application of CAD programs throughout the stages of building 
design.

Both authors are Autodesk® Certified Professionals and Associate Professors at the department 
of Architectural Technology and Construction Management at VIA University College in Aarhus, 
Denmark.
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        INTRODUCTION
This is Volume II of ‘Revit - BIM and Concept Design’. Using Volume II assumes Revit 
knowledge and skills aquired though the steps of Volume I or at a similar level.

Briefly on BIM and Revit®

This section is mainly for readers not yet familiar with the concept of BIM. Readers already famil-
iar with this from Volume I can skip this section.

Revit is a CAD1-programme supporting BIM.

BIM is an abbreviation of Building Information Modeling, a certain method of working and collab-
orating digitally in a building project. The word Model refers to the fact that designing with BIM 
is always 3D modeling. Using BIM methods in a building project requires using digital object-ori-
ented parametric tools that support BIM. Parametric and object-oriented here means, that the 
program operates with objects that are more than plain geometry, but have parameters specific 
to their nature and function: Windows ‘know’ they are windows and can be set in Walls or Roofs 
only, they can have parameters like ‘width’, ‘height’, ‘frame material’, ‘U-value’ etc. Parametric 
also implies that a project can be changed through changing parameters - e.g. the thickness of 
a certain Wall Type can be changed, and immediately all walls of this type in the project will be 
displayed in all drawings with the new thickness.

	 Revit is one such parametric BIM-supporting tool among many.

At the core of BIM is the idea that all information in a project is kept in one single database - The 
Building Model (or sometimes referred to as the BIM, the Building Information Model), a 3D 
parametric model shared between all participants of the project. All documents in the project - 
drawings, lists, schedules (and in a wider BIM perspective also budgets and time schedules) are 
drawn ‘automatically’ from this model/database.
In order to derive reliable and sufficiently detailed information from the model - drawings, lists 
etc. - all necessary information needs to be added to the model in the first place - by us, the 
designers of the building.

	 In our case, the Revit Project File is this shared database.

The potential benefits of using BIM in a building project can be considerable, especially in medi-
um- to large-scale projects. For educational purposes, BIM is here introduced in a project smaller 
of scale and in the early stages of design. Some advantages evident even at this scale and stage 
are:

Consistency - All drawings are generated from the same 3D model.

Ease of change - Many aspects of the project are easily changed2, e.g. room dimensions, storey 
heights, wall thicknesses, surface materials etc.

Control - already very early in the modeling process it is easy to keep track of core project 
parameters. e.g. gross building area, room areas, storey heights etc. The building model being 
relatively ‘intelligent’, it is easy to ‘ask’ it relevant questions.

1	 CAD: Computer Aided Design
2	 There are drawbacks, however; at the very early stages, when sketching the building layout, the main focus is on the 
overall geometry of the building. At this stage, a core demand to a drafting tool will often be swiftness of response to radical 
change of geometry, allowing the designer to quickly test very different layout scenarios. Most BIM programs available at 
present may appear unnecessarily bulky and slow to the designer at these first design stages, often asking for input that 
may not yet be relevant.

II
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The case
In this case study, it is assumed that you are working in a small architects office on designing a 
detached one family house for private clients. A draft layout of the building plan has been made 
prior to you setting up the project in Revit. When modeling the building, you start from this initial 
draft layout, shown on inserts in the back of Volume I.

By the end of Volume II, you will be ready to submit a set of drawings for a full concept design 
proposal, and during the progress, you will gradually get introduced to the Revit tools needed to 
create, modify and document the Building Model.

Volume I
Early in the design process, you need to show preliminary drawings to the clients for them to 
comment. A basic Building Model is created using most of the basic Revit tools, allowing you to 
generate a first set of drawings in Revit by the end of Volume I (see figure I and II)

Figure I
The Building Model at the stage of 
the preliminary proposal in Volume I

Figure II
Cross section at the stage of the 
preliminary proposal in Volume I
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Volume II (this volume - digital version only)
While generating the preliminary output in Volume I, you have been waiting for the land surveyor 
to provide a Site Model with exact 3D information about the site. In Volume II, this is now brought 
into the project, allowing you to refine the design of the building and particularly how the building 
and the existing physical conditions interact.
You can opt to create the Site Model yourself in various ways. These lessons are found in the 
back of Volume II in the appendix Site.
Based on the detailed 3D information now present in the model, some aspects of the design is 
reconsidered. Split levels are introduced in the building at this stage.
The clients now return to you with changes to the brief. This requires some remodeling and 
involves the use of many of Revit’s Editing tools and functionalities as well as introducing some 
more advanced Revit tools. At this stage, an extra storey is added to the building. Finally, draw-
ings for the client of the finished concept design proposal is generated from the Revit building 
model.
Found as an appendix to Volume II is also a chapter on advanced presentation techniques - ren-
derings, video clips and interactive panoramas etc.

Figure IV
Cross section at the stage of the 
final concept design in Volume II

Figure III
The Building Model at the stage of 
the final concept design in Volume II
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How to use this book
The book is structured as a practical learning guide and a reference book.
The progression of the case study is similar to that of many real life projects.
The titles of the main chapters frame the overall topic of the progress at the given stage of the 
development of the project.
The introduced progression can be seen here:

Volume I
1.  preparations		  BEFORE MODELING
2.  building I		  BASIC MODELING
3.  documentation I	 PRELIMINARY DRAWINGS

Volume II (digital version only)
4.  building+site		  GROUNDING THE PROJECT
5.  building II		  PROJECT CHANGES
6.  documentation II	 FINAL DRAWINGS

Appendices to volume II
A  the context		  SITE
B  documentation III	 PRESENTATION

The page opposite is an example of how a page in the book is structured, explaining in general 
terms how to use the book as an instruction while working in Revit to learn the program.
The case study can be approached in different ways:

•	 Chapter by chapter, from the beginning to the end
•	 A single chapter or section at a time, one by one, in any order

To work through single chapters or sections can be helpful if one specific Revit technique needs 
to be learned or tested. In this case, please go to the associated website www.bimbogen.dk. to 
download the Revit models available here.
These are models of the case study at different stages of progression. By opening one of these, 
the user can work from a certain point without having to complete the previous chapters or 
sections. Whenever a model is available, the file name of the model will be highlighted in the 
procedure text (see ‘A typical page’ opposite).

As well as being a case study for learning Revit, the book can be used for future reference. 
The index in the back of the book refers where Revit tools, themes and overviews are introduced.
Only tools, themes and overviews introduced in this volume are referred in the index. For basic 
tools, themes and overviews, see the index in Volume I.

It is presupposed that the user of this volume has basic Revit skills and general basic computer 
experience. Thus, the text may refer to basic Revit routines explained in Volume I and basic 
mouse actions (Double-click, Cick and drag etc.) without further explanation.

A capital letter in the beginning of a word (like Wall) indicates that the word refers to a Revit term.

How to use Volume II
To use this digital volume as a learning guide while working in Revit on a computer, it is handy to 
have it open on a separate screen, e.g. a tablet, rather than on the same screen as Revit.

A Reference Sheet showing the final revised project to be elaborated in chapter 5 is available for 
download on bimbogen.dk in the same location as this present volume. Whenever needed, the 
sheet is referred in the text of chapter 5.
For ease of use, please download the Reference Sheet and print it.
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The procedure title above intro-
duces the overall objective of 
the work procedure described 
here.

Procedure step 1
For overview, the procedure 
text is broken into steps. Each 
step is introduced by a subtitle, 
like the one above.
In general, the text will tell you 
exactly what to do. Revit Com-
mands and Revit-technical 
terms will be shown in Bold.

When a new command is in-
troduced it is referred in the 
margin.

1  A number in the text refers 
to an illustration from the Revit 
user interface shown above. 
The referred illustration will 
have the same number shown 
in a black circle.

2  In the first part of the book, 
all steps and commands will be 
thoroughly described. Along 
the progress, commands and

routines already familiar will 
not be explained in detail.

File: Revit Case Study 2.2 pXI

Highlighted text like the above 
in the procedure text indicates 
that a Revit model elaborated 
to this exact point of progres-
sion is available for download 
on www.bimbogen.dk/models.
The filename of the Revit mod-
el is shown in the box and re-
fers to the relevant chapter, 
section and page in the book.

Figures
Figures provide an overview of the overall progression of 
the building model at the given stage.

1

2

Themes 
Text formatted in italics on grey background ex-
plain some core themes in Revit. This can be 
important functionalities or aspects of Revit that 
need explanation to supply an overall under-
standing.
The themes explained are topics of a wider Re-
vit relevance than the specific context in which 
it is shown.
For ease of reference, these themes are listed in 
the index in the back of the book.

PROCEDURE/ Detailed instructions step by step

A typical page
Here, the subject of this stage in the over-
all procedure is being introduced. This can 
be a sub-procedure in the overall design 
process, a Revit command or a routine 
of commands: Its general purpose and 
its purpose in the case study, the overall 
method in a design process in general an 
in Revit in particular, wider application, ad-
vice and some aspects that may need spe-
cial attention.

For ease of reference, introductions will 
sometimes be followed by an overview in 
bullet points (see below).

•	 This summarizes a series of 
routines spanning several pag-
es, or even a whole chapter.

•	 The overview is for reference 
and not detailed. For more de-
tail, go to Procedure below.

•	 The topic of each overview is 
listed in the index in the back of 
the book.

OVERVIEW/  For reference

Revit command intro-
duced in the text
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GROUNDING THE PROJECT4
This chapter picks up the building project where we left it in Volume I.

We assume that detailed 3D information about the existing conditions of the site 
is now made available. This enables us to design in response to the site in a more 
qualified way. A more precise knowledge of topography, plantation and other con-
textual elements of the site may influence our thoughts on how to place a building 
here. Thus, we will make some changes to the project in order to achieve the 
optimal interaction between building and site.

First, we will establish the relation between the building and the site in a BIM 
environment. Then, considering the terrain, we will introduce split levels in the 
building. This in turn affects room heights, so we reconsider also the roof.

Revit-wise, Site tools and Stairs will be introduced, and we will also look into 
some new tools for creating Roofs.

By now, following the step-by-step instructions in Volume I, the basics of Revit® 
have been introduced and some routines may start to feel familiar.
At this point in your progress in Revit skills, the written instructions in the proce-
dure bar will be less detailed. Whenever Revit tools introduced in Volume I are 
needed, they will be referred to only briefly with no full explanation.
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Depending on how deep you need to go 
into learning about modeling topography in 
Revit, select one of the following scenarios:

Scenario 1
A land surveyor has sent an AutoCAD file 
(.DWG) with 3D site information.
Go to APPENDIX A: SITE, section A.1 and 
follow the procedure to generate a Revit 
Site Model based on the AutoCAD model. 
Return to this chapter after completing the 
model.

Scenario 2
Only 2D cadastral data is available, either 
hard copy or as a digital image from a web 
platform.
Go to APPENDIX A: SITE, section A.2 and 
follow the procedure to create a Revit Site 
Model from scratch based on the 2D site 
data. Return to this chapter after complet-
ing the model.

Scenario 3
A land surveyor has sent a Revit Site Model.
Download the file Revit Case Study SITE 
SURVEY on bimbogen.dk and  continue in 
this chapter.

Our newly acquired detailed site informa-
tion needs to be communicated into the 
Building Model. This is done by Linking 
the Site Model into the Building Model.

We will then establish the relation between 
building and site - decide exactly where to 
place the building on the site.

4.1/  SETTING THE BUILDING

OVERVIEW/ 
Setting the building

•	 While in the Building Model, 
Link the Site Model

•	 In the Building Model, relocate 
the site in relation to the build-
ing as desired (horizontally and 
vertically)

•	 Acquire Coordinates from Site 
Survey Model

•	 In the Building Model, Bind the 
Site Model

Figure 4.1.1
Site Model linked into Building Model
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Download the file ‘Revit Case 
Study SITE SURVEY’ from 
BIMbogen.dk and unpack it - or 
create a Site Model following 
the instructions in chapter A.1 
or A.2.
Make sure to place the Site 
Model in your project fold-
er (BIM Projects/Revit Case 
Study).
Leave the file here and do not 
open it. Instead, open your 
Building Model.

File: Revit Case Study 4.0 p3

Delete site elements
Go to View Site.
In the Drawing Area, Select 
all preliminary site elements 
from previous stages: Planta-
tion, Toposurface and Detail 
Lines. Use any method of se-
lection learned.
Delete all Selected objects.

Link Site Model

1 In the Tab Insert, click Link 
Revit.

2 Browse to the project fold-
er and pick Revit Case Study 
SITE SURVEY.rvt. Set Posi-
tioning to Auto - Origin to Ori-
gin. Click Open.
Review Model

3 Zoom out to see the whole 
site in a larger scale; Right-
click and pick Zoom To Fit - all 
elements visible in this view 
will now be within the Draw-
ing Area. Keyboard shortcut is 
(ZE).
Site View should look like Fig-
ure 4.1.1.

Link Revit

Zoom to Fit

PROCEDURE/ Linking the Site Model

21

3

Link Models together
To communicate site information into the 
Building Model, the Site Model is Linked 
into the Building Model. 

The linked file is referenced and can be 
seen in the Building Model, but not edited 
here. Often, the Building Model and the 
Site Model will remain two separate mod-
els throughout the design process.
However, since this is a relatively small proj-
ect, we will break the link to the Site Model  
by Binding it in order to be able to edit the 
site while working in the Building Model.

Linking a number of models together is of-
ten done in large projects, enabling com-
plex model environments to be established 
while still keeping file sizes to a minimum. 
Linking is also widely used to keep the 
Building divided between different disci-
plines with each their separate fields of 
responsibility. Each Model (Architecture 
Model, Landscape Model, Systems Mod-
el, Structural Model etc.) will then hold only 
building elements belonging to one disci-
pline, and the complete building can be 
seen only by linking them all together, e. g. 
in one Master Model.
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Rotate Linked Site Model
Select the Linked Site Model.

4 Start the Rotate command.

5 Click on the center of rota-
tion (the blue dot) to pick it up.

6 Click on this endpoint of 
the northern Site Boundary 
to place the center of rotation 
here.

7 Click on the opposite end-
point to start rotating from here.

8 Move the cursor down until 
snapping to horisontal.
Click to finish rotating the 
linked Site Model.

The northern Site Boundary 
should now be shown horison-
tal in the View.

Rotate

4

5

6

7

8

PROCEDURE/ Positioning the building on site

Position the building on site

Technically, the process in Revit of po-
sitioning the building on site is actually 
the opposite:  We will not Move or Ro-
tate the building, instead we Move and 
Rotate the Linked Site Model!
This is important, since Moving or Rotat-
ing a building already modeled in Revit’s 
3-dimensional space would be very com-
plicated.

First, we will Rotate the site correctly 
according to the building, and then we 
will Move the site to position the build-
ing correctly.

Moving the site must be done in three 
dimensions: X, Y (horisontally) and Z 
(vertically). 

In the Site View, we adjust the X and Y 
position, Moving the Linked Site Model.
For privacy, the north-facing external 
Wall is kept at a distance of 4,5 meters 
from the Site Boundary.

Finally, we will go to a Section View and 
move the Linked Site Model in the Z-di-
rection.
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Move

Visual Style: 
Wireframe

Move in X and Y-direction

9 Select the Linked Site Model 
and start the Move command.

10 Click at the endpoint of the 
two intersecting Property Lines  
to start moving the Site Model 
from this specific point.

11 Click on the snap point 
where the north and east fa-
cade intersect. Click to place 
the Site Model here temporarily.

The building will be hidden un-
der the Site Model. Set the Vi-
sual Style to Wireframe to see 
through the Site Model.

12 With the Site Model still 
Selected, start the Move com-
mand again (MV).

9

11

10

12
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14

16

13

Figure 4.1.2
Moving Linked Site Model in Y-direction

Figure 4.1.3
Moving Linked Site Model in X-direction

Measure

15

13 Click in a random spot to 
start Moving the Site Model 
from here.

14 Drag the cursor upwards, 
snapping to vertical, and type 
4500.
End the command.

The building should now be 
positioned correctly in the Y-di-
rection - 4,5 meters from the 
northern Site Boundary. We will 
now control if this is the case.

15 In the Quick Access Bar, 
activate the Measure tool to 
check if the distance is correct:
Click first anywhere on the 
northernmost external Wall, 
then on the northern Site 
Boundary.

The measured distance will 
display both in the Drawing 
Area and in the Options Bar.

16 Carry out a similar thread 
of actions to position the build-
ing correctly in the X-direction 
(horisontally). The east-facing 
wall should be positioned 8 
meters from the eastern Site 
Boundary.
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Figure 4.1.2
Moving Linked Site Model in Y-direction

Figure 4.1.3
Moving Linked Site Model in X-direction

20

Move in Z-direction
Now we need to adjust the ele-
vation of the building.
First, we need to estimate 
the height of the ground floor 
(above sea level). Our first es-
timation based on viewing the 
survey plan is 47 meters - this 
can be adjusted later.

Go to Elevation North. 

17 In the View Control Bar, 
click Do Not Crop View to turn 
on the visibility of objects out-
side the crop region.
The building may be hidden 
behind the mass of the Topo-
surface now visible. 

18 Set Visual Style to Wire-
frame to see the building again.

Double-click the scroll wheel 
on your mouse to Zoom to Fit.

Select the Site Model and start 
the Move command.
Click anywhere in the Draw-
ing Area and move the cursor 
downwards, snapping to verti-
cal direction, and type the de-
sired move distance (47000). 
Press enter.

20 Set Visual Style to Hid-
den Line on both Site and 
North Elevation.

19

Figure 4.1.4
Moving Site Model down

Visual Style: 
Hidden Line

Zoom to Fit

18

17
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Figure 4.1.5
Site View with Orientation 
set to Project North

Acquire Coordinates

Orientation

Import information
Go to the Site View.

1 In Properties, notice that the 
Orientation is set to Project 
North. Walls are displayed ver-
tical and horisontal. (see Fig-
ure 4.1.5).

2 In the tab Manage, click on 
Coordinates and start the Ac-
quire Coordinates command.

3 Click on the linked Site Mod-
el to take the information from 
here.

Review Model 

4 In Properties, set Orienta-
tion to True North. The View 
should change and look like in 
Figure 4.1.6.
Switch Orientation back to 
Project North.

Figure 4.1.6
Site View with Orientation 
set to True North

PROCEDURE/ Acquiring Coordinates

1

2

4

3

Aquire coordinates

The Site Model contains 
not only information about 
existing physical objects (to-
pography, plantation etc.), 
but also information about 
the the whereabouts in the 
world:

- Direction of the True North
- Height above sea level 
(Shared Elevation).

We will now transfer this 
information from the Site 
Model to the Building Model 
using the command Aqui-
re Coordinates. This is 
possible only because the 
Site Model is linked into the 
Building Model.

True North and Project North
Revit operates with two different directions both called north: 
Project North and True North.

By default, all Plan Views are oriented towards Project North. 
Also by default, True North is set to be the same direction as 
Project North.
In most cases (when dealing with rectangular building plans), a 
building is not oriented exactly north/south. When modeling in 
plan Views, it is practical to have the building oriented towards a 
direction which is not the true north, but rather a direction close 
to north, allowing us to view the plan with as many lines as pos-
sible parallel to horizontal or vertical. This direction is called Proj-
ect North and is also often a direction of reference shared and 
agreed on between parties involved in the design process.

This far we have been working in Views set to Project North. The 
Site Plan, however, is normally shown with True North orientation.
At this point we therefore need to distinguish between Project and 
True North, and to specify the True North.
One way to do this is to Acquire Coordinates from a linked Site 
Survey Model.
Alternatively, the command Rotate True North can be used.
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1

Figure 4.1.7
One combined Building 
and Site model

PROCEDURE/ Binding the Site Model

2

Bind Link

Ungroup

Bind Site Model
In the Site View, Select the 
Linked Site Model.

1 Click Bind Link.

2 Clear the list and click OK.

3 Click OK to the Warning 
(Types from this project will be 
used).

4 Click Remove Link to break 
the Link to the Site Model.
The Linked Site Model is now 
converted to a Group.

Select the Group.

5 Click Ungroup.
The Toposurface should now 
be editable.

5

Bind the Site Model

The two Models could be left like this - one 
linked into the other, and changes made 
individually to both.
In a small project like this it is easier to 
break the link between the Site Model and 
the Building Model, making it one single 
Revit Project file. 

When breaking the link, objects from the 
Site model becomes editable object in the 
Building Model. 
Binding does not affect the original linked 
file.

3

4
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Label Contours Label Contours

1 Set the Visual Scale of the 
Site View to 1:500.

2 In the Tab Massing and Site, 
click Label Contours.

3 Click in one end of the Topo-
surface to start a line of Con-
tour Labels here.

4 Draw a line perpendicular to 
the contour lines. Click in the 
opposite end of the Toposur-
face to end the Contour Labels 
here.
Looking at the Contour Labels, 
we can see that they show the 
Project Elevation (see Figure 
4.1.8)

Adjust Contours
In the Drawing Area, click to 
Select the Contour Label.

5 In Properties, click Edit Type.
Duplicate the Type.

6 Name the new Contour La-
bel Type 1.5mm Arial - Survey 
Point.
Click OK.

Figure 4.1.8
Contour Label showing Project Elevations

PROCEDURE/ Documentation of coordinates

1
2

9

Elevation coordinates

In this project, Shared Elevation is set to refer 
to the height above sea level aquired from the 
Survey Model. Project Elevation is set to re-
flect elevation above the finished floor surface.
Levels in Elevation and Section Views are set 
by default to reflect Project Elevation.
Project Elevation is already set correctly be-
cause the Elevation of the Ground Floor was 
set to 0 when we started modeling.
The correct setting for Shared Elevation was 
aquired from the Site Survey Model when we 
used the command Aquire Coordinates.

Elevations - Project vs. Shared
Just like Revit operates with several norths - 
True and Project - also several parallel sys-
tems of elevations are used. At this point we 
need to distinguish between two: Shared Ele-
vation and Project Elevation.

Like it is the case for Project and True North, 
Project and Shared elevation is set by default 
to be the same at the outset of a project.

4

3
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7 Click on the arrow to set 
the Elevation Base to Survey 
Point.

8 Now click to Edit Unit For-
mat. First, uncheck Use Proj-
ect Units and then set Units 
to Meters and Rounding to 2 
decimal places. Click OK.

9 In the Massing & Site tab, 
go to the Model Site group and 
click on the small arrow to see 
Site Settings.

10 Adjust settings as shown.
All elevations shown are Proj-
ect elevation.

11 We want all Contour Lines 
to set out from sea level (47 m 
below Project Elevation origin) 
- type -47000 in these fields. 

Review Model
The Contour Labels should 
now display the Shared Eleva-
tion as in Figure 4.1.9.

7

Units Format

Site Settings

5

8

8

Figure 4.1.9
Contour Label showing Shared Coordinates (in this case height above sea level)

6

10

11

11
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4

5

Preparations

1 Go to the View 3D. Select the 
Floor. Go to the Type Selector 
and change the Floor Type to 
Generic - 400mm (Ground).

Set up Type
Go to Site.

2 Set Visual Style to Wire-
frame. 

3 In the tab Massing and Site, 
start the Building Pad com-
mand. Edit Mode is now active.
Before drawing, adjust these 
settings:

4 In Properties, set Height 
Offset From Level to -400.
The top of the Pad will be posi-
tioned 400 mm lower than Lev-
el 1 - right under the Floor.

5 In the Type Selector, make 
sure that Generic Pad - 2mm is 
selected.

PROCEDURE/ Building Pad

Building Pad
We have now positioned the existing terrain 
relative to the building. Still, it is not evident 
in 3D View how the terrain and the building 
interact. One part of the building is float-
ing in air, another seems to be submerged 
in earth with no clear intersection lines. A 
clear meeting between the two needs to be 
established.

To bring terrain and building together in 
a project like our case study, designing 
a ‘heavy’ building appearing to rest on a 
base (i.e. with linear foundations, not sup-
ported on piles etc.), we place the building 
on a Building Pad.

In Revit, a Building Pad is a horisontal pla-
nar object, much like a Floor, used for plac-
ing in or above a Toposurface.
Unlike a Floor, however, it will ‘carve out’ a 
void in the Toposurface from its underside 
and upwards. If the underside of the Pad is 
placed above terrain level, the in-between 
space will be ‘filled up’.
Thus, the Building Pad can be conceived 
as a planar excavation or gradation lined 
with gravel or sand, preparing for the place-
ment of a building.

At a Concept Design stage, we are only 
interested in the ‘levelling’ properties of 
the Pad, not yet its structure or thickness. 
Therefore, we will create it with minimal 
thickness.

Building Pad

3

Figure 4.1.10
The building with the originasl Floor, before adding the Building Pad.
One part of the building appears to be floating in the air, another is submerged.

2

1
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6

8

Draw Building Pad

6 Start drawing the Pad 
Boundary. Use drawing tools 
learned earlier: Pick Lines or 
Line.

7 The Pad Boundary lines 
should be aligned to the out-
er edge of the external Walls. 
Remember that the Boundary 
Lines must form a closed loop.

8 In the tab Modify, click the 
green tick to finish the Pad 
Boundary.
Go to 3D View and check the 
result - it should look like Fig-
ure 4.1.11.

Figure 4.1.11
The building with Building Pad added, cutting the terrain and forming a base.
It is now easier to see the position of the Floor in relation to the terrain.

7
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4.2/ ADJUSTING BUILDING TO SITE I

•	 Set up new Level
•	 Create new Floors or edit the 

existing
•	 Split and adjust existing Walls
•	 Create Foundation Walls
•	 Review model and make cor-

rections as necessary
•	 Adjust Furniture and Casework 

to new Levels

OVERVIEW/ 
Splitting Levels

The first step in the process of adapting the 
building and the site to each other will be to 
adjust the building to the terrain.
We will try to accommodate the Floor Level 
of the building to the terrain by lowering the 
floor in some rooms, splitting the levels of 
the house. This requires some adjustments 
to Walls and Floor.
In Volume I, we used the Floor element as 
a simple base for the building, extending 

under the external Walls. In this chapter, 
we will model proper foundation walls un-
der the external Walls.
We will also use the Floor tool for modeling 
terraces outside.

Before setting out to modify the model, we 
will sharpen our viewing tools to get better 
orientation while working.

Figure 4.2.1
Stages of the development of the Building 
Model in chapter 4.2

1. Split Levels

2. Foundations

3. Terraces
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2

2

3

File: Revit Case Study 4.2 p15

Create WIP Section Views

1 Go to Level 1 and create 
two new Sections: View > Sec-
tion. They will automatically be 
named Section 1 and Section 
2. See Figure 4.2.2.

Rename Section 1 to WIP Sec-
tion 1 and Section 2 to WIP 
Section 2.

Create 3D WIP Section

2 Select these two Walls.

3 In the Contextual Modify 
Tab, start the Selection Box 
command.

A new 3D Section View is gen-
erated. Press ESC to Deselect 
the two Walls.

WIP Views: Generating a better overview

PROCEDURE/ Generate overview

As the model becomes more complex, it 
becomes increasingly important to orga-
nize our means of viewing it in order to see 
properly the impact of our modeling and 
editing actions. 
For this, we will set up some WIP Views 

to better enabling us to watch the model 
in detail.
WIP is short for Work In Progress, indicat-
ing that the Views are not Output Views, 
but only for inspecting the model while 
working.

1

Figure 4.2.2
Two new Sections created
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4 In Properties, rename the 
View to 3D Section West End.

5 Set the Discipline to Ar-
chitectural. This will move the 
View to the correct folder in the 
Project Browser.

6 Set the Visual Style to Hid-
den Line.

7 Click on the edge of the 3D 
Section Box to Select it.

8 Drag the top Control down 
to cut back the Roof.

9 Drag the bottom Control 
down to display topography un-
der the building.

10 Select the Topography and 
press VH to hide the Category 
Topography.

11 Turn on Shadows. If shad-
ows are too dark, go to page 
35 of Volume I to see how to 
adjust them.

4

6 11

7

8

9

5

10
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Set up Levels
Go to WIP Section 1.

1 To create a new Level, go to 
the tab Architecture > Datum 
and start the Level command.

2 In the Drawing Area, click to 
draw a new Level 600 below 
Level 1.

3 Select the new Level and re-
name it Level 0.

4 Click Yes to rename the cor-
responding view.

Along with the new Level 0, a 
new Floor Plan has automat-
ically been created (see the 
Project Browser).

5 Select the Floor and press 
DELETE.

1

4

3

5

2

Split Levels I

PROCEDURE/ Splitting Floors

Level

Seeing the building set in the terrain and 
considering the slope under the building, it 
now seems reasonable to try to make the 
design respond more closely to the terrain.

We will change the design and split the 
floor levels, introducing a new floor level 
below the current in the western end of the 
building.

Revit-wise, this is done by creating two 
Floors instead of one. We will set up a new 
Level in Revit to control the new Floor.

The edge of the Floor already created 
could be adjusted to accomodate the new 
design. Instead, we will Delete it and create 
a new Floor in its place - this will some-
times be easier than editing.
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8

Figure 4.2.4
New floor boundary Level 1

Floor - Level 1
Go to Level 1.

6 Go to Architecture > Floor  
to start the Floor command. 
Start creating a new Floor of 
the Type Generic - 400mm 
(Ground) using the same meth-
od as before.

7 In the Type Selector, pick 
Floor Type Generic - 400 mm. 
(Ground).

8 The floor boundary must 
be drawn according to Figure 
4.2.4.

9 When finished, click Finish 
Edit Mode.

9

6

7
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Floor - Level 0
Go to Level 0 and zoom in on 
the west end of the building 
(see Figure 4.2.5).
Start creating a Floor.

10 Draw a boundary accord-
ing to Figure 4.2.5. Note that 
the boundary must be aligned 
to Wall and Door faces.

Review Model

11 Go to 3D Section West 
End. Orbit in the View to in-
spect the two Floors from dif-
ferent angles.

11

Figure 4.2.5
New floor boundary on Level 0

10
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2

5

4

4

4

3

1

Split External Wall

1 Go to floor plan Level 0. Se-
lect the northern Wall.

2 From the Modify Contex-
tual Tab, select Split Element 
Tool.

3 Move the scalpel over the 
wall until a tooltip appear; 
Walls: Basic Wall: Generic - 
480 mm (Exterior). Click to split 
the Wall in two - aligned to the 
right side of the Internal Wall. 
Zoom in for precision.
We will adjust the cut on the 
next page.

4 Select these three Walls. 

5 Set Base Constraint to Lev-
el 0. Press ESC to Deselect the 
Walls.

Go to the View 3D Section West 
End and review the changes.
Go back to Level 1 again.

Split levels II

PROCEDURE/ Split levels II: Walls

Split Element

Finally, elements such as Walls, Windows, 
Fixtures and Furnitures must be adjusted 
to correspond to the changes in floor level.
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Adjust Wall Joins

6 A correction is necessary 
where the north Wall is split. 
Select the Internal Wall and 
right-click over the blue dot. 
Pick Disallow Join.

7 Drag the Internal Wall end 
perpendicular to the inside of 
the outer wall.

8 Drag the External Wall end 
perpendicular to the right side 
of the Internal Wall; While drag-
ging, you can hold SHIFT to 
align to the right side of the in-
ternal wall face.

Split Internal Wall
9 Split the internal wall us-
ing the same methods as de-
scribed before.

9

Figure 4.2.8
3D Section View of the walls base 

set to different Levels

8

Disallow Join

7

6
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11

11

10

10

10
10

10

15
15

16

15

16

1212

13

14

14

Figure 4.2.9
The model with all elements 

placed on the right Level.

Place elements on level 0
Go to Level 1.

10 Select these five Internal 
Walls. In Properties, set Base 
Constraint to Level 0.

Use same procedure for:

11 Internal Doors

12 Windows

13 Door/Window Assembly

14 Casework

15 Furniture

16 Model Groups

10
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19

20

Flip SectionEdit Wall Profile
Instead of splitting a Wall,  Edit 
Wall Profile is also an option.

17 Select Section 2 and click 
on the Flip handle (the double 
arrow) to view of the internal 
Wall from the hallway.

18 Select the Wall and click 
Edit Profile.

19 Close the Warning (Top 
and Base of Wall will be reset). 

20 Select Section 2 and click 
Open View.

21 Adjust the Walls profile ac-
cording to the sketch.
Click Finish Edit Mode.
Press ESC to Deselect Wall. 

Go to 3D Section West End 
and take a look at the progres-
sion so far.

21

17

18

Figure 4.2.10
Adjusting view direction on a Section

21
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2

5

4

3

File: Revit Case Study 4.2 p24

Create new Wall Type
Go to Level 1.

1 Start the Wall command; Ar-
chitecture > Wall. 
Choose the Wall that match-
es your next move: Generic - 
450mm (Foundation).

2 Click Edit Type.

3 Click Duplicate and name 
the Type Generic - 480 (Foun-
dation).

4 Click Edit and set the Wall 
thickness to 480. Click OK > 
OK to finish.

5 In the Options Bar, note that 
Walls will be drawn as  a depth.
Set Unconnected height to 
1300, Location Line to Finish 
Face Interior and enable Chain 
to draw multiple Walls in one 
routine.

Foundations

PROCEDURE/ Creating Foundation Walls

Figure 4.2.11
The building model with Foundation Walls added

1

Wall (Foundation)

So far we have worked with two Families of 
Walls: Basic Walls and Curtain Walls. Ex-
ternal walls and partitions are both created  
as Basic Walls but with different functions. 
In the Type Properties, we can see that the 
Function is set to Interior (inner wall) and 
Exterior (outer wall). 
In Revit, Foundations are Basic Walls with 
the Function Foundation.
The behavior of a Foundation function is 
that the default Height is determined as 
Depth!

Foundations Walls are normally modeled 
after the external Walls. At this stage, we 
will model them having the same thickness 
as the Wall above.



254.2/ ADJUSTING BUILDING TO SITE IREVIT - BIM AND CONCEPT DESIGN - a case study/ Volume II

Start

Start

End

End

Create Foundation Walls I

6 Start drawing Walls from this 
point (interior side of Wall).

7 If you get a warning, read it 
and ignore it! This notifies that 
none of the created elements 
are visible in the floor plan.

8 End the chain of Walls here.

Go to Level 0 and follow the 
same procedure to create the 
three remaining Foundation 
Walls (see Figure 4.2.13). 

Review model
Activate the 3D View to review 
the foundation Walls. For a bet-
ter view, Select the Topography 
and press VH to Hide it in this 
View.

6

8

Figure 4.2.12
Adding foundations under Walls on Level 1

Figure 4.2.13
Adding foundations under Walls on Level 0

7
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Create Foundation Walls II

9 On Level 1, apply a founda-
tion underneath each of the Wall 
pillars.

10 Create foundation under-
neath the garden Wall. 

Cleaning up geometry 
Since we made the Floor to go 
to the backside of the Windows 
and doors, we now have double 
geometry.
Go to 3D Section.

11 Start the Join command.

12 Select the Foundation.

13 Click on the edge of the 
Floor to Join the two. If you find it 
difficult to select the Floor, hold 

the cursor still over the Floor 
edge and press TAB again and 
again until the Floor is highlight-
ed.
Without moving the cursor, click 
to Join the two.

Complete the rest of the building 
where the foundation is visible.
You have to extend the 3D Sec-
tion View to see all Foundations 
and Floors.

11

12

9

13

9

9

10

Figure 4.2.14
The building model with Foundations 

added under the external Walls

Join Geometry
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Elevated terrace
Go to Level 1 and start the 
Floor command.

1 Create a new Floor Type by 
duplicating Generic - 100mm 
(Ground).
Name it Generic - Wood 
120mm (Exterior).
Set the Function to Exterior 
and the Thickness to 120. 

2 Draw the boundary lines ac-
cording to the sketch above.
Finish the Floor command.
In the pop-up box, tick the box 
Do not show this message 
again and click on Don’t attach 
(we don’t want the adjoining 
foundation Walls to be at-
tached to the underside of the 
Floor, neither now or when ed-
iting Floors in the future).

Hard landscaping

3 Go to Level 0 and start the 
Floor Command and create a 
new Floor Type: Generic - Con-
crete 100mm (Exterior).
To be able to adjust floor level 
in specific areas, set the floor 
to be Variable. 

1

2

3

Terraces 

PROCEDURE/ Creating terraces 

Terrace, patio

Revit does not have a terrace or a patio com-
ponent.
Plan terraces can be made by creating 
Floors with their Function set to Exterior. 

Sloped paved areas can be created in the 
same way and have its slope adjusted using 
the Modify Sub Elements tool, but if in a hur-
ry, a visual indication of areas in the terrain 
having a different surface can be achieved by 
specifying separate regions in a Toposurface, 
using the tool Subregion introduced further 
in this section.
We will try all the different methods in the 
case study to create:
- A light (wooden) terrace placed above the 
terrain in floor level.
- A paved area 100 mm. below floor level. The 
area outside the main entrance door will be 
adjusted to have direct access without steps.
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Figure 4.2.14
Floor boundary - west terrace and carport

4 Create a concrete terrace 
towards west. Draw boundary 
lines according to the sketch 
and set the Height Offset 
From Level to -100. Finish 
Floor.

5 Go to Level 1 and create a 
new terrace & carport floor. 
Draw boundary lines according 
to Figure 4.2.14.
Again, set the floor height to 
-100 and Finish Floor.

Set up Reference Planes

6 Create two new Reference 
Planes outside the Main En-
trance: One 1500 mm from the 
Wall at the entrance, and one 
further 2100 mm away.

4

4

6 6

5
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Making a Ramp

7 Select the Floor and click 
Modify Sub Elements.

8 Click Add Point.

9 Add four point where the 
Reference Plane intersect with 
the Floor.

10 Click on a point to change 

the height. Click on 0 (zero) 
and set the height to 100. 

11 Select the three other 
points and do the same. Press 
ESC twice to finish modifying 
the height.

Model review
This will make a plateau in front 
of the main entrance door.

Go to the 3D View to check 
out the models progression. 
Note that the underside of the 
Floor is even because we set 
the thickness to Variable. See 
Figure 4.2.15.

12 We have double Geometry 
where Foundation and Floor 
meet. Use Join to repair it.

7

8

11

12

11

10

119 9

9 9

Figure 4.2.15
The models with a Ramp outside the entrance door

Modify Sub Elements

Ramp
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3

2

1

4.3/  ADJUSTING SITE TO BUILDING

PROCEDURE/ Grading the terrain

File: Revit Case Study 4.3 p30

Preparations
Go to the View 3D.
If the terrain is not visible in the 
View, Unhide it.

Phasing

1 Select the Toposurface in 
the 3D View. Set Phase Creat-
ed to Existing. 

2 Read the Warning. Click OK 
to accept that Subregions must 
have the same Phase.

Create new Toposurface
Go to the Site View.

3 In the Tab Massing & Site, 
start the Graded Region com-
mand.

Phasing

Having allowed the building to respond to the 
terrain by introducing split levels, we will now 
make changes to the existing topography.
Hence, the main topic of this chapter is the 
creation and modification of the terrain based 
on the existing.
A concept introduced in this connection is 
Phasing. All elements have a phase of cre-
ation and a phase of demolishing. By default, 
new elements created in the model have 
Phase Created set to New Construction and 
Phase Demolished to None.

The existing terrain should have its Phase 
Created set to Existing and Phase Demol-
ished to New Construction, while the new 
modified terrain should have its Phasing Pa-
rameters set like the elements of the rest of 
the proposed building.
Among many other uses, Phasing of terrain 
can be used to immediately extract exact 
information about earth work from the BIM 
model - of high relevance at the stage of con-
cept design.

•	 Appoint Phase to existing Topo-
surface

•	 Create new Toposurface, set 
Phase created to New

•	 Adjust new toposurface to corre-
spond to building

OVERVIEW/ 
Adjusting topography to Building
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5

6

4 Select Create a new topo-
surface exactly like the exist-
ing one.

5 Click on a contour line.
A new Toposurface have been 
created in exactly the same 
position as the existing and its 
Phase is automatically set to 
New.

The new Toposurface will now 
be available for editing.

Grade terrain

6 Move the Interior Points one 
by one to a position outside the 
terrace east of the building. 
Go back to Modify / Edit Sur-
face Tab Click Finish Surface.

7 Select the New Toposurface 
and check the Net cut/fill val-
ue in Properties. You can see 
that a minor amount of the soil 
has been moved.
Press ESC to deselect the 
Toposurface.

In projects on sloped sites, grading the ter-
rain - moving, adding and deleting points in 
the toposurface - is a process that requires 
frequent reviewing in different Views: 3D, 

Sections and elevations.
Also in the process, the elevation of the build-
ing may need to be reconsidered.

Figure 4.3.1
Creating a new terrain

Graded Region

Grade the terrain

7

4
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10 To make all Points on 
Contour Lines visible, change 
the View Range of the view. 
In Properties, click Edit View 
Range. Set both Bottom Pri-
mary Range and View Depth 
Level to Unlimited.

11 Select the New Toposur-
face again and click Edit Sur-
face. 

12 Move the three Interior 
Points from inside the building 
according to the sketch. 

Review Model

13 Do not finish Edit Mode. 
Check the 3D View. You will 
see that a detailed correction is 
necessary (the floor disappear 
under the terrain).
Rotate the 3D View to get a 
good view of the East side. 

13

13

12

12
Figure 4.3.2
3D View of the site before final adjustment

10
10

11
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Place more points

14 Start the Place Point com-
mand.

15 Set the Elevation to -110.

16 Place new Points along the 
outside of the  Terrace Floor and 
in front of the main entrance. 
See Figure 4.3.3. and 4.3.4.

Adjust surface
Now fine-tune the rest of the 
elevations according to Figure 
4.3.3. Switch to Site view if it 
makes a better view.

Click the green tick to Finish 
Surface.

Hide existing topography 
Go to Site.

17 To hide the existing Topo-
surface, select Show New in 
Phase Filter. Only the new 
elements (Toposurface) will be 
visible in this view.
This can be done in any Views.

Figure 4.3.3
Project Elevation of Points by zones surrounding the building

Figure 4.3.4
Adjust Toposurface in 3D View

14

15

16

16

17

Place Point

Phase Filter

-110

-110

-150

-710

-750 -210
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2

Building Pad I: Modify
Go to Site. Hold the cursor over 
the exterior side of the External 
Wall. In this location the exist-
ing Building Pad is created.

1 Press TAB until you see the 
Pad in the Status Bar (lower left 
corner on your screen). Click to 
select the Building Pad.

2 Click Edit Boundary.
Adjust the Building Pad to the 
outside wall face and Floor 
boundary on Level 1. See Fig-
ure 4.3.5.

3 Set Height Offset From 
Level to -400.

Figure 4.3.5
Building Pad under Level 1

PROCEDURE/ Additional sitework

Additional sitework

1

3

Apart from the terrain being graded, also 
the buildings footprint on the terrain must be 
adjusted after splitting the levels. We will ad-
just the Building Pad previously created and 
place another under the lowered part of the 
building.

Also, the tool Subregion is introduced as a 
means of subdividing the surface of the ter-
rain.
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7

Subregion

6

Figure 4.3.7
Driveway created with Subregion

Figure 4.3.6
Building Pads under Level 0

Building Pad II: Create

4 Create a new Building Pad  
on Level 0 (Massing & Site > 
Building Pad) following wall 
faces and floor boundaries ex-
actly as shown in Figure 4.3.6. 

Set Height Offset From Lev-
el to -400. Click Finish Edit 
Mode.

5 Create the third Building Pad 
around the pillar on the south-
west corner using same proce-
dure as before. 

Create driveway

6 Create a driveway from the 
road to the house: Massing 
and Site > Subregion.

7 Draw a boundary as shown 
in Figure 4.3.7 and Finish Edit 
Mode.
Save the model.

4

5
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4.4/ ADJUSTING BUILDING TO SITE II

Figure 4.4.1
Progression in Chapter 4.4

•	 Adjust View Templates
•	 Add Stairs
•	 Trying different Roof designs

OVERVIEW/ 
Adjusting Building to Site II

In the beginning of this chapter, we changed 
the design of the building to follow the ter-
rain by introducing one more floor level.

Then, we needed to adjust the natural ter-
rain to follow the levels of the building more 
closely.

Now we are ready to make the final 
fine-tuning by connecting all levels inside 
and outside with Stairs.
Having a variation in floor levels, it is also 
worth to look for a roof design to help gen-
erate a variation in ceiling heigths.

2. Roof Design

1. Stairs
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1

52

3

4

View Template

PROCEDURE/ Organizing Views

File: Revit Case Study 4.4 p37

Review model

1 In the Project Browser, 
click the + (plus) to expand 
the Sheet A1.41 - Perspective 
South - West. Double-Click 
to open the 3D View Exterior 
South - West to see the chang-
es you made to the terrain.  

Notice that the existing terrain 
is visible. In most Views, we 
want only the new terrain to be 
visible.

Edit View Templates

2 Edit View Template Concept 
Design 1 - Perspectives.

3 Set the Phase Filter to 
Show New.

4 Click Edit to Override Model.

5 Uncheck Primary and 
Secondary Contours under 
Topography to hide Contour 
Lines in view. Click OK twice 
to finish and to apply chang-
es to not only this view, but all 
views with this View Template 
assigned.
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Stairs

Stairs in Revit consist of the Components 
Runs, Landings and Supports. One Stair 
can have any number of each of these 
Components.
Three Families of Stairs are available:

•	 Assembled Stairs
•	 Cast-In-Place Stairs
•	 Precast Stairs

Cast-In-Place Stairs and Precast Stairs 
are characterized by being manufactured 
in one piece (monolithic) in a factory or on 
site. The material is normally concrete.
Assembled Stairs are composed of several 
individual components. The material is pri-
marily wood or steel.

Stairs can be created using two different  
tools: By Component or By Sketch.
Creating simple stairs is easiest done By 
Component, which is a highly automated 
tool, whereas Stair By Sketch provides for 
more freedom of design to create Stairs of 
many different shapes; Straight, L-shape, 
U-shape, spiral, and highly customized 
stairs.

When the Stair command is activated, it is 
assumed that you want to create a stair be-
tween two Levels. The number of Treads 
for a Stair Run is generated automatically 
based on the distance between Levels and 
the Maximum Riser Height defined in the 
Stair Type.

Cast-In-Place Stair
Precast Stair

Assembled Stair
Support: Stringers
Riser: None

Assembled Stair
Support: Stringers
Riser: Yes

Assembled Stair
Support: Left and right Carriage
Riser: None

Assembled Stair
Support: Middle Carriage
Riser: None

Assembled Stair
Support: None
Riser: None

Figure 4.4.2
Stair Families and sub Components
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6

1

2
3

StairStairs I: Set up Type

1 Go to Level 0 and start 
Stair command; Architecture 
> Stair. Select Cast-In-Place 
Stair Monolithic 280 mm go-
ing - 175 mm riser.

2 Click Edit Type. Duplicate 
and Name the new Stair Type; 
Monolithic 250 mm going - 
200 mm riser.

3 Set Maximum Riser Height 
to 200 and Minimum Tread 
Depth to 250. Click OK. 

4 Set the Desired Number of 
Risers to 3.

5 Select Run type Straight.

6 Select Location Line Run 
Left.

Stairs I: Create

7 Draw the stair from left to 
right, snapping at an approxi-
mate position on the inner wall.

PROCEDURE/ Creating Stairs

7

5

S
ta

rt

E
nd

Stairs can host Railings. Railings are gen-
erated automatically when Stairs are cre-
ated - if not needed, these can be deleted. 
New Railings can be placed on Stairs at 
any time.

In this case study, we will use the method 
Stair By Component to create a Cast-In-
Place Stair and an Assembled Stair.

In Chapter 5.4 you can find more informa-
tion on Railings, Landings etc.

4
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Stairs I: Relocate

8 Click to select the Stair. Drag 
the Stair’s Controls to adjust 
width to the opposite wall face. 

9 Move the stair to the edge of 
the floor on Level 1 using Align 
or Move. 

Stairs I: Review model

10 Go to 3D Section West 
End. Here, you’ll have a better 
view to the Stair. 

11 Click Finish Edit Mode. 
Delete the two Railings, we 
don’t need them now.

9

8

10

Figure 4.4.2
Exterior stairs between terraces

11



414.4/ ADJUSTING BUILDING TO SITE IIREVIT - BIM AND CONCEPT DESIGN - a case study/ Volume II

13

16

12

18

20

14

16

15

17

Stairs II: Set up Type

12 Go to Level 0 and zoom in 
to the south-west corner and 
start Stair command. Select 
Assembled Stair Stringer (250 
mm. going - 180 mm riser).

13 Set Base Offset to -100 
because the stair must start at 
the top of the terrace.

14 Click Edit Type.

15 Set Function to Exterior.

16 Set Right & Left Support 
to None. 

17 Click to edit Run Type.

18 The stair must be without 
risers. Uncheck Riser.

19 Set the Nosing Length to 
100. Click OK + OK.

Stairs II: Create and relocate

20 Draw the stair from the  
wall face. Extend the Stair to 
the pillar. Move or Align the 
Stair to the floor edge. Delete 
the Railings. Finish Edit Mode.

18

19
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Figure 4.5.1
Pitched roof with gable end and eaves and a garden wall on the west facade

A consequence of introducing split levels 
in the building is the rooms having different 
heights. This could have an impact on the 
architecture of the house in different ways.
Trying to further integrate the slope of the 
terrain into the architecture of the building, 
we will now create a Roof by specifying a 
Profile rather than previously its Footprint, 
introducing Roof by Extrusion.

Creating a Roof by Extrusion is done by 
sketching the Profile in a vertical plane, 
and then extruding the profile by specifying 
the ends of the Roof.
To shield the terrace established and to 
integrate it spatially with the interior of the 
building, a garden Wall is introduced.

Roof III: Pitched with eaves, custom profile

1

2

3
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Figure 4.5.2
Roof Profile

PROCEDURE/ Creating custom profile Roofs

File: Revit Case Study 4.4 p43

Preparations
Go to WIP Section 1 and De-
lete the existing Roof and the 
Sunshaders.
Go to Level 1.

1 Create a Ref Plane 700 out-
side the western external Wall. 
Select it and name it West. Pin.

2 Create another Ref Plane 
700 outside the entrance fa-
cade (naming not important). 
Pin.

3 Move WIP Section 1 to the 
Living Room (view direction 
east).
Go to WIP Section 1 and ex-
tend the Crop Region.
Change the elevation of Level 
2 to 2600.  

4 Create a horizontal Ref 
Plane 1900 mm above Level 2.

5 Create a horizontal Ref 
Plane 600 mm below Level 2.

6 Create a vertical Ref Plane 
400 mm outside the northern 
external Wall face.

7 Create a vertical Ref Plane  
800 mm outside the southern 
external Wall Face.

Create Roof

8 Go to Tab Architecture > 
Roof > Roof by Extrusion. 

9 Specify Reference Plane: 
West as the Work Plane.
Click OK. 

10 Specify Level 2 as the 
Roofs Reference Level and 
click OK.
In the Type Selector, select Ba-
sic Roof Generic 500mm. 
Draw the lines snapping to in-
tersections - the lines indicate 
the upper side of the Roof. See 
Figure 4.5.2.

11 At the ridge, snap to the in-
tersection between the top Ref 
Plane and the extension of the 
left Wall face. Click Finish Edit 
Mode.

12 In Properties, set Rafter 
Cut to Two Cut - Plumb and 
Fascia Depth to 200.

4

5

6 7

8

9

10

11

12

Reference Plane - named

Roof By Extrusion
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Copy Roof
Go to Elevation North.

13 Align and Constrain the 
left end of the Roof to the Ref 
Plane outside the entrance.

14 Select the Roof and start 
the Copy command.

15 Copy from the Wall edge...

16 ... to Wall edge.
Now the Eastern edge of the 
Roof is in place.
To adjust the Roofs Western 
edge, start the Align and Con-
strain command

17 ...and click first on the Ref 
Plane on the inside of the en-
trance Wall,

18 ...then on the Roof edge to 
extend it to the Ref Plane.

Adjust Roof profile
Move WIP Section 1 to cut 
through the kitchen Window.
Flip it to view towards west.
Activate it.
Double-click on the Roof to 
Edit its Profile.

13

15

16

18

17

14

Copy
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19 Select the right sketch line 
and start the Move command.
Now click twice to Move the 
sketch line from A to B:

20 ...from the top outer edge 
of this external Wall (A)...

21 ...to the top outer edge of 
this external Wall (B).
Start the Move command 
again...

22 ...and move from Ref 
Plane...

23 ...600 mm vertically up to 
Level 2.

Finish Edit Mode to save the 
changes made to the Roof.

20

21

22

23

Edit Profile

Move

19

A

B
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Review model
Go to View {3D} to check the 
Roof from all sides.

24 The two Roofs overlap.

25 The Walls do not reach the 
Roofs or is above the roof.

26 Start the Join command 
and Join the two Roofs.
Attach all Walls - except Cur-
tain Walls - to the two Roofs. 
An easy way is:

27 Right-click on a Wall and 
pick Select all Instances > In 
entire Project. Click Attach 
Top/Base  and click on one of 
the Roofs. 

28 This Warning may appear 
- click Detach Targets to avoid 
Attaching objects that are not 
touching each other.
Click Attach Top/Base  again, 
and click on the other Roof. 

Repeat, until all Walls - exterior 
and interior - are attached to 
the Roof above them.

29 This Window needs resiz-
ing. Select it, Edit Type > Du-
plicate > set up new Type.
Set Rough Height of the new 
Type to 800 and rename ac-
cordingly.

26

24

25

27

29

Select all Instances

28
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Create garden Wall
Go to Level 0.
Start the Wall command.

1 In the Type Selector, pick 
Type Generic - 480 (Exterior) 
from the Family Basic Wall.
Set Height to Unconnected 
and Unconnected Height to 
2200.

2 Create a Wall in the location 
shown.

Create a Foundation Wall un-
der the Wall like previously de-
scribed. 

3 If the Building Pad is hidden, 
Unhide it. Edit its Boundary 
to align with the new Garden 
Wall by changing the Western 
boundary and adding some 
lines.
Finish and review the model in 
3D View.

PROCEDURE/ Creating a garden Wall

2

1

3
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Edit View Template

1 Open one of the Elevations 
placed on a Sheet, e.g. South 
Facade.

2 In Properties, click to edit the 
assigned View Template.

3 Edit V/G Overrides Filters. 

Create new Filter

4 Click Edit/New to create a 
new Filter.

5 Create a new Filter and 
name it WIP Sections.

6 Check Section Category.

7 Set the Filter Rules  to Filter 
By; View Name - Begins With 
- W. Click OK to go back to pre-
vious window.

PROCEDURE/ Hiding WIP Sections by View name

Filters 

6

7

5

As a project becomes increasingly com-
plex, many Views are needed in the proj-
ect to be able to inspect all corners of the 
model properly.
As Views are added, the Views tend to 
become cluttered with references to other 
Views.

To tidy up a bit, we will now hide certain 
View references in certain Views. To auto-
mate the process and to make the visibili-
ty of View references behave according to 
our needs also in the future, we will do this 
using Filters.

Hide View references by automation

1

2

3
4
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Filtering for process automation
All Revit objects belong to a Category of multiple 
Families.
Each Category has a standard appearance setting 
that is applied to all objects in a category.  Appear-
ance settings control visual object characteristics 
like Line Color, Line Weight, and Line Pattern. 
These settings can apply to an entire project or to 
individual Views. 
We have tried to change these settings previously 
in the book.

Sometimes it is useful to Hide objects with cer-
tain traits within a Category, but to keep other ob-
jects of the same Category visible. In the Visibility/
Graphics Overrides menu, this can be controlled 
by using Filters, setting up Filter Rules.

To Filter an object is to point it out for further 
processing. A Filter Rule defines by which attri-
butes in the objects Parameters it is appointed.

In this case, objects are Filtered to Hide them, but 
filtering can be used to point out objects to be pro-
cessed in other ways also.

Add Filter

8 Click Add to find the Filter 
you created before.

9 Select the Filter and click 
OK.

10 Uncheck Visibility. All 
Sections where W is the first 
letter, will now be invisible in 
this View.

Add Filter to other Views
This Filter can be applied to all 
other Views where you don’t 
want to see the WIP Sections.

8

9

10
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5

3

6

Plan View

1 Go to the Sheet A.10 - 
Ground Floor Plan. Expand the 
list of Views on this Sheet by 
clicking on the +. Remember 
that Level 1 and Ground Floor 
Plan are two different Views. 
Do not double click the View.

2 Note that the terraces are 
not completely visible. 

3 Select the Viewport (the 
building on the Sheet), right-
click and Activate View (or 
double click) to make it edit-
able. The View Ground Floor 
Plan is now ready for adjust-
ment.

4 Click Show Crop Region.

5 Drag the Controls to adjust 
crop. Click Hide Crop Region 

(same button as Show Crop 
Region).

6 Right-click and click Deacti-
vate View (or double click out-
side frame) to exit edit mode.

Review the Sheet with the Lo-
cation Plan. Consider the crop-
ping in the same way and cor-
rect if necessary.

Adjust Sheets and Output Views (optional)

PROCEDURE/ Adjusting Sheets and output Views

Presenting the changes made to the client 
would be a natural next step.

Because of the changes to the building, an 
adjustment of the Sheets and of the output 
Views is needed. 

1

2

2

4
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Section and Elevation Views
Go to the Sheet with the output 
Section Views.
To show the recently added 
and modified elements (Roof, 
terrain and foundation Walls) 
optimally, adjust the cropping 
and the position of the Views 
on the Sheet as shown in Fig-
ure 4.5.3.

Go into each Section View, one 
by one, and make the following 
corrections.
Some Walls may need to be At-
tached to the Roof.

To show the difference between 
existing and new topography, 
we will not hide the existing ter-
rain (shown dashed). However, 
we want to make it transparent, 
so it does not hide the bottom 
of the outside opening.

7 Select the existing terrain.

8 Right-click and go to Over-
ride Graphics in View > By 
Element.

9 Expand the group Surface 
Transparency and set Trans-
parency to 100.

10 A cavity is now visible 
between the underside of the 
terrace Floor and the Building 
Pad.
This can be corrected by ad-
justing the Building Pad to not 
include the terrace, and then 
create a separate Pad under 
the terrace (optional).

Review the Sheets with Eleva-
tion Views to make similar cor-
rections.

8

9

7

Figure 4.5.3
Sheet with adjusted Section Views

10

Overwrite Graphics 
in View by Element
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PROJECT CHANGES5
Like real-life projects, changes occur frequently along the course for many rea-
sons at any stage in the project - which is why a process that balances detail and 
effort is encouraged in this case study: A modest level of detail, generic Element 
Types and Constraints (used with consideration together with Reference Planes) 
are means to keep this balance.

While waiting for the clients to respond to our preliminary proposal, we have been 
occupied with feeding the project with information concerning the physical sur-
roundings, causing us to propose some changes to the project.

Now the clients reply with radical changes to the brief, forcing us to reconsider 
the project thoroughly.

This chapter will to a large degree be an exercise in using Modify tools and a 
repetition of modeling tools already learned.
A few new tools and concepts will be introduced, and the Stairs tools will be ex-
amined more closely.
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Due to changes in family and work rela-
tions, the clients need more space than 
implied in the original brief. This and other 
changes to the brief is demanded:

•	 One extra room which can function as a 
home office and also occasional meet-
ings with a client

•	 One more adult occupant in the house
•	 One room to let if possible
•	 Higher levels in the house to benefit 

from the view to the landscape
•	 More storage in the kitchen
•	 Brick as exterior wall material

The revision of the Revit project will be 
based on a revised sketch proposal shown 
on the Reference Sheet available for down-
load and print on the website; keep this at 
hand for reference while making the chang-
es and additions to the project.
Also, this page and the previous pages 
supply an overview of the revised proposal.

To modify elements that are already cre-
ated is a core subject of the exercises in 
the chapter - so is repetition of Revit tools 
already learned.

5.1/ CHANGES TO BRIEF

The revised sketch proposal: Concept

Figure 5.1.1
Concept of the revised proposal. The building divided in two:
A massive northern slab and a transparent southern slab
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5.2/ PLAN ADJUSTMENTS

Preparations

Before setting out adding more space in 
the building to address the change of brief, 
there will be some revisions to do.
Some of these support the change of 

spatial concept - dividing the building in a 
northern and a southern slab - and some  
are minor changes of refinement, introduc-
ing some new Revit tools and methods.

File: Revit Case Study 5.0 p55

Purge obsolete elements
Go to (3D). Delete all roofs.
Go to Level 1 and Delete Ref 
Planes used for creating the 
Roofs.

Adjust building perimeter
Go to (3D), navigate to see the 
south-western corner of the 
building.

1 Delete Pad and Foundation 
Wall under the corner Wall pil-
lar.

2 Select south- and west-fac-
ing external Walls and Reset 
Profile of both.

3 Trim the Wall ends back to 
the adjoining external Walls as 
shown, using Trim/Extend to 
Corner.

4 Navigate to see the 
south-eastern corner of the 
house and do the same to the 
east-facing Wall.

PROCEDURE/ Preparations and miscellaneous revisions
Reset Profile

1

2

4

4

3

3
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Go to Level 1.

5 Copy Ref Plane 480mm to 
the right. Pin.

6 Select the southern external 
Wall and Drag its eastern end 
to the new Ref Plane, using the 
Drag Control.

West-facing glass facade

7 Still in Level 1, create a Ref 
Plane here (aligned to the Wall 
face) and Pin.

Select the west-facing external 
Wall at the living area.

8 In the Type Selector, set its 
Type to Curtain Wall. The in-
serted Door will be deleted in 
the process.

9 Select the south-facing ex-
ternal Wall and Align its end to 

the Ref Plane.

10 Select the Curtain Wall 
and position it 300 from the in-
ner Wall face as shown, using 
Temporary Dimensions.

Go to Elevation West.
Add Curtain Grid to Curtain 
Wall: one vertical in the middle 
and one horizontal at the Ref 
Plane ‘Top apertures’.

5

5

6

7 8 9

10
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11 Add Mullions to Curtain 
Walls: Exterior - 50x115mm 
Add them to all Grid Lines.

12 Select the bottom right 
Panel of the Curtain Wall 
(press TAB multiple times to 
select). In Type Selector, set 
Type to CW Ext. Sliding Door 
- Glass.

Apertures in south facade
Go to Level 1.
Delete all Windows and Cur-
tain Walls in the south-facing 

external Wall.
Start the Door command, pick 
Type Ext. Sliding Door Window 
Assembly - Glass.

13 Edit Type > Duplicate 
> 3480 x 2200mm, set Door 
Width to 1740 and Rebate 
Depth to 300.

14 Place a Door in the 
south-facing external Wall and 
Align and Constrain the right 
edge to the Ref Plane as shown.

15 Select and Copy the Door 
3960 to the left. Select the orig-
inal Door again and start the 
Copy command. In Options 
Bar, tick Multiple. Copy from 
point to point as shown twice.

Go to Elevation South.
Select again the south-facing 
Wall. Edit Profile.

16 Draw an opening as 
shown. Remember to Con-
strain its edges to Ref Planes 
whenever possible.

14

15

16

12

11

13

15

15

Curtain Grid

Mullion 



58 5 building II - PROJECT CHANGES

Internal Sliding Doors
Go to Level 1.
The Doors to rooms #1 and #8 
need to be replaced with slid-
ing Doors (see revised floor 
plan on page 1 of the Refer-
ence Sheet). Select the Doors 
and exchange their Type to M9 
x 22 of the Family Int. Sliding 
Door on Wall.
Align and Constrain the edg-
es of the Doors’ openings to 
the adjacent Wall faces.

Glazing at entrance

17 Create an embedded Cur-
tain Wall in the north facade at 
the entrance according to the 
revised plan on page 1 of the 
Reference Sheet. Set its rebate 
depth to 50 - but first, move the 
entrance Door away  from the 
corner while setting up the 
Curtain Wall.

Go to Elevation North.
Align and Constrain the top 
of the Curtain Wall to the Ref 
Plane ‘Top apertures’.

18 Create a vertical Grid Line 
in the Curtain Wall and locate it 
107.5 from the Wall end.

Start the Mullion command 
and set Type to Rectangular 
Mullion - Exterior 50x115mm.

19 Set Placement to Grid 
Line Segment.

20 Click to place it in these 
three locations.

21 Set up another Mullion Type 
- 115 x 115mm - and place it on 
the Grid Line you created before.
Leave the remaining Grid Lines 
with no Mullions.

17

18

20

21

19



595.2/ PLAN ADJUSTMENTSREVIT - BIM AND CONCEPT DESIGN - a case study/ Volume II

22 Select the narrow end 
Pane of the Curtain Wall (use 
the TAB key to pick it) and set 
its Type to Empty.
Go to Level 1.
Select the entrance Door and 
assign a new Type based on 
the current. Set the Width of 
the new Type to 1560.

23 Align and Constrain it to 
the Curtain Wall Mullion as 
shown.

Model review
Go to (3D) and check if all 
changes seem correct. In par-
ticular, check if Foundation 

Walls and Building Pads need 
to be adjusted.

24 Also, check if Floor edges 
are in the right position. Adjust 
as necessary - use Align and 
Constrain.

Hide Furniture
Go to Level 1.
In the following sections, we 
will change partition Walls first 
and adjust fixtures and furni-
ture afterwards. To get fixtures 
and furniture out of the way in 
Level 1 while remodeling the 
partition Walls, we will Hide it. 

You can hide all fixtures and 
furniture in a View easily this 
way:

25 Select a piece of furniture. 
In the View Control Bar, click 
Temporary Hide/Isolate > 
Hide Category.
Do the same for the Categories 
Casework and Plumbing Fix-
tures.

Temporary Hide

23

22

24

25
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Move Wall: Corridor
Go to Level 1.

1 Select the partition between 
the corridor and the living area. 
Align it to the Ref Plane.

2 You may get Warnings - read 
these. It is fine to Unconstrain. 
Some warnings may relate to 
the issues below (read further).
See more about Warnings in 
chapter 1.

Review model
NB. Notice that we have moved 
the line where the levels in 
the house change. The edges 
of the Floors and the Building 
Pads below should move along 

with the Wall - but they will do 
so ONLY if the edges were 
earlier Constrained to the Wall 
edge. If they have not moved, 
Move them manually now:

3 Go to 3D Section West End 
, unhide the Section Box and 
adjust it to cut the model like 
shown. Hide fixtures and fur-
niture temporarily if necessary.
Check if the following have 
been moved along with the 
Wall:
- The Floor edge at Level 1.
- The Floor edge at Level 0.
-The Building Pad edges at 
both Levels.

If an edge has not moved, 

Select the element and Edit 
Boundary. While still in 3D 
Section View, Align and Con-
strain the magenta edges to 
the proper Wall Face. Finish 
Edit Mode.

NB. Note that Building Pads 
are not allowed to overlap!
So if edges of both Building 
Pads need to be moved, move 
first the edge of the upper 
Building Pad (below Level 1).

4 The Elements should inter-
sect like this when adjusted 
correctly.

PROCEDURE/ Making room for the stairs

Make room for the stairs
To make room for the stairs to the upper 
storeys, a Wall need to be moved. This 
involves editing the step between Level 0 
and 1.  

3

4

1

2
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Move Wall: South Facade
Go to Level 1.

1 Select the external Wall and 
the adjacent Doors and Move 
them 360 mm vertically down.

Move also the outer edges of 
the terraces, so they are not 
narrower than before (ill.): Se-
lect the terrace > Edit Bound-
ary > Select the edge and 
Move. Finish Edit Mode.

Review model
As before - and always - the 
model should be reviewed after 
changes: Have Floor edges, 
Building Pad edges, Founda-
tion and Stairs edges moved 
along with the Wall? (ill.)
Like before:
Go to a 3D Section View to 
check, correct if necessary, us-
ing Align and Constrain.

2 It is also a good idea to go to 
WIP Section 1 to check if the 
Foundation has followed the 
Wall.
NB. Remember to Edit Bound-
ary in order to move only the 
Floor Edges and not the whole 
Floor.

PROCEDURE/ Resizing the living/dining room

Resize the living/dining room
The living area was made smaller to give 
room for the stairs - now, to gain back 
some space for the living area, an external 
Wall is moved, changing the footprint of the 
building.

1

2
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Edit Wall Profile

1 First, Delete the two Walls 
and the two Room Separation 
Lines shown.
Ignore any Warnings about 
multiple Rooms in the same 
enclosed area and click OK - 
do not delete Rooms.

2 Next, drag the eastern end 
of the Wall to the end of the 
building.
Move and Flip WIP Section 2 to 
face the Wall from the living/din-
ing room. Go to WIP Section 2.

3 Select the Wall and Edit 
Profile. Now change the Wall 
Profile as shown.
Useful drawing tools are Pick 
Lines, Line (can be used with 
Offset), Trim/Extend to Cor-
ner, Offset or Copy, Align and 
Constrain. Wherever possible, 
remember to Constrain to Ref 
Planes rather than to other 
Walls. 
Finish Edit Mode.

Review model
Go to (3D) to check the result. 
If Walls cross with no visible in-
tersection lines, Join them.

4 Select the low Wall between 
the kitchen and the corridor. 
In Properties, change its Top 
Constraint to Level 2. If the 
Wall  has disappeared, create 
a new.

PROCEDURE/ Dividing the plan

Divide the building
A core concept of the revised proposal is to 
divide the building in two slabs - one facing 
south and one facing north.
The division line is a wall in the middle, 
spanning the full length of the building.
To achieve this, we will make the partition 
Wall between the stairs and the living area 
continuous through the whole interior of 
the house and pierce it to maintain connec-

tions between the north and the south side 
of the house.

This and the following section is dealing 
with ways to control how to make Revit el-
ements intersect in simple ways to avoid 
issues of over-constraining or element 
corruption, even in a layout of moderate 
three-dimensional complexity.

2

1

3
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Edit partitions
Go to Level 1.

1 Change from this...

2 ... to this (see also revised 
plans on page 1 of the Refer-
ence Sheet).
Use tools learned previously to 
Delete, Split, and Move Walls, 
and to create niches in the 
Walls for the tall cabinets.

Useful tools are: Unconstrain, 
Extend/Trim to Corner, De-
lete, Align, Constrain, Wall 
Opening or Edit Profile.

Review model
Go to (3D) to check the changes. 
If you have used Wall Open-
ings to create niches for the 
tall cabinets, go to WIP Section 
2 to check the height of the 

openings. Adjust the height of 
the Wall Openings according to 
the top of the cabinets.
Alternatively, you could Align 
and Constrain the top of the 
Openings to the Ref Plan ‘Top 
apertures’, and then Edit the 
Cabinet Type to fit the height of 
the Wall Opening.

PROCEDURE/ Optimizing the kitchen layout

Optimize the kitchen layout
To get more storage space in the kitchen, 
some Wall niches are introduced, and the 
bathroom rearranged.

1

2
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Rearrange

1 In View Level 1, Reset Tem-
porary Hide/Isolate to view 
furniture and fixtures again.
View fig. 5.2.1 for Components 
used and their approximate lo-
cation. The wall-hung toilet can 
be loaded from the DanEDU 
folders. Distribute Components 
as shown.
Tools to use: Move, Copy, 

Align, Mirror - Draw Axis, 
Load Family.
Notice that Components can 
be Flipped by selecting the 
Component and then press 
SPACEBAR.
When using the Move com-
mand, some Components can 
only be moved horizontally 
or vertically. To overrule this, 
press down SHIFT while Mov-
ing the Component.

Adjust heights
Remember to check in Sec-
tion  View if the top of the tall 
cabinets align with the top of 
the wall niches. If not, select 
a tall cabinet and Edit Type to 
change its height so it aligns to 
the top of the Wall Opening.

PROCEDURE/ Rearranging fixtures and furniture

Rearrange fixtures and furniture
To finalize the changes made so far, the 
furniture need to be rearranged to match 
the new layout.

1

Figure 5.2.1
Furnitures and Fixtures on Ground 
Floor Plan of the revised proposal
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Set up Levels
Go to Level 1 and move WIP 
Section 2 to cut through the in-
ternal Stair.
Go to WIP Section 2.

1 In the View Control Bar, ad-
just Crop Settings so the View 
is not cropped.
Select Level 2 and set Ele-
vation to 2600 if not already 
done.

2 In the Project Browser, Re-
name Level 2 to Level 3 by 
Right-clicking (rename corre-
sponding views: Yes).

3 In the Tab Architecture, 
start the command Level and 
draw to create a new Level at 
its approximate elevation. Ad-
just elevation to 2000. Name it 
Level 2.
Create Level 4 at elevation 
4400.

4 Tidy up the Level symbols 
in the Section View: Select a 
Level Tag (the large circle) and 
Drag it by the tiny circle to be 
aligned to one or other Level 
Tags.
Levels are 3D Model elements, 
and once Tags are aligned, 
they will line up in all parallel 
Views.
Go to WIP Section 1 and do 
the same.
Pin all Levels!

PROCEDURE/ Creating Floors

5.3/ ADDING UPPER STOREYS

Floors

At this stage, the upper storeys of the re-
vised proposal are modeled. First, Levels 
are set up and Floors created, then Walls, 
Roofs, apertures, and Roofs.

By then, we will create the main stairs and 
have a closer look at Revit’s Stair tools.

The first step towards adding the upper 
storeys is creating the Floors. To do this, 
we will first set up more Levels - one for 
each of the new Floor levels, and one for 
the upper Roof.
Each new level created will automatically 
generate an associated Plan View.
To avoid getting the Project Browser clut-

tered with Plan Views - and because in 
many projects, Levels is a main organising 
concept - it is good practice to create no 
more Revit Levels than one for each Floor 
level in the project.
Like on the ground floor level, we will locate 
the boundaries of the Floors aligned to the 
inner face of the external Walls.

Level

1

3

3
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Adjust external Walls

5 Go to (3D). Select the exter-
nal Walls of Level 0 (the par-
terre storey).

6 In Properties, set Top Con-
straint to Level 2 and Top Off-
set to -400.

Adjust View Settings
Go to Level 2. In Properties 
set the Underlay to Level 0.
Notice that all furniture at Lev-
el 0 is gray. This indicates that 
it is only visible in this View, 
because it belongs to a Level 
used as Underlay. To avoid 
confusion, Temporary Hide fix-
tures and furniture as before.

Create mezzanine Floor
Start the command Floors and 
pick the Type Generic - 300mm. 
In Properties, set Offset to 0.

7 Use the drawing tool Pick 
Wall. Use the Flip Controls 
(the blue double arrows) to 
control on which edge of the 
Wall to locate the Floor edge.
When the Pick Wall tool is 
used, edges are constrained 
to the Wall even though no 
padlock symbols have been 
shown.

8 Draw as shown.

9 Adjust the position of the west-
ern edge of the Floor like this.

Trim/Extend to Corner to form 
a closed loop.
Finish Edit Mode.

10 Response No to any que-
ries about Joining or Attaching 
Walls to the Floor - we will do 
this manually now to control of 
how Walls attach to the new 
Floor.

Review Model

11 Go to (3D) and navigate to 
see the intersection between 
Floor and Walls. Select the 
Walls shown and Attach to the 
new Floor.

Pick Wall

5
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8
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Create upper Floor
The upper Floor slab will also 
serve as ceiling above the 
kitchen and the bathroom.
Stay in (3D).

12 Set Work Plane to Level 3. 

13 Create Floor (like before,   
now in (3D)).
Other Warnings may pop up. 
Leave Wall/Floor joining to do 
manually afterwards.

Review model
Still in (3D), select all the Walls 
coming up through the new 
Floor and Attach Top to Floor. 

14 Tip: Right-click one Wall 
> Select all Instances of the 
Same Type > Attach all at 
once.

15 This Warning may appear. 
Pick DetachTarget(s).

Go to Level 1.
Select the west-facing external 
Wall to control how the Wall 
joins the other external Walls at 
the corners.

16 We want it to join like this 
at the corners. If they do not, 
use the command Wall Joins 
to adjust as needed.

Go to (3D).
Select the west-facing Wall at 
Level 0 and Attach the Top/
Base to the Floor above.

Set Work Plane

Wall Joins

12

13

12

15

16
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Create external Walls
Go to Level 2.
Start the Wall command.
Set Type to Generic - 480 (Ex-
terior).
In the Options  Bar, set Top 
Constraint to Level 4 and Lo-
cation Line to Finish Face In-
terior.

1 In Properties, set Base Off-
set to -400.

2 Create Walls as shown - re-
member to draw clockwise.

Go to Level 3.
Set  Underlay to None if con-
venient.
Start the Wall command.
Set Type to Generic - 480 (Ex-
terior).
In the Options  Bar, set Height 
to Level 4 and Location Line 
to Finish Face Interior.

3 In Properties, set Base Off-
set to 0.

Create the remaining external 
Walls as shown.

4 Set the Base Offset of the 
south-facing external Wall to 
600, and add 600 to the height 
of the inner wall using Edit 
Wall Profile.

Create partitions
Go to Level 2.
Start Wall command, set Type 
to Generic - 120mm (Interior).
In the Options  Bar, set Height 
to Level 4 and Location Line 
to Finish Face Interior.
Create Walls as shown on the 
revised plans on page 1 of the 
Reference Sheet. Some Walls 
can be drawn in the correct lo-
cation immediately, some can  
better be drawn at an approx-
imate location and moved in 
place afterwards, using Tem-
porary Dimensions. 

5 Select the three walls and 
set Base Constraint to Level 3 
and Height to Level 4

Model review
Go to (3D) and check the model.

6 The model should look like 
this, with no Walls overlapping 
and the Base of all partitions 
aligned to the surface of the 
Floor below it.

7 To remove any intersection 
lines between flush Wall faces, 
use the Join tool to Join Walls.

Rooms
Go to Level 2 and create the 
Rooms located here. Do the 
same on Level 3.

PROCEDURE/ Creating Walls

Walls
Next step is creating the Walls - first the 
external, then the partitions.
The external Walls will be located to enve-
lope the new Floors created, whereas the 
partitions will be positioned to rest upon 
the Floors.

7

6

4

5

1

3

2

Join



695.3/ Adding upper storeysREVIT - BIM AND CONCEPT DESIGN - a case study/ Volume II

Create Roof with eaves
Go to Level 2.
In the Tab Architecture, start 
the command Roof by Foot-
print.
Set up a new generic Basic 
Roof Type with Thickness 250. 

1 Set Base Offset From Lev-
el to 300.

2 In the Options Bar, set Off-
set to 800 for eaves.

3 Draw as shown (no offset on 
north side).

4 To make the Roof mo-
no-pitched, set only the south-
ern edge to Define Slope and 
set Slope to 12.00°.
Finish Edit Mode.

Go to WIP Section 1.

5 In the Quick Access Toolbar, 
activate Thin Lines Mode for 
better orientation.

6 Copy the new Roof from this 
Endpoint

7 to this Intersection.

8 Select the upper Roof and set 
Rafter Cut to Two Cut - Square 
and Fascia Depth to 250.

PROCEDURE/ Creating Roofs

Roofs
Finally, the Roofs are created to finish the 
primary elements of the building.
The southern roof need its full thickness 
only above the interior rooms (to allow for 
the thickness of the insulation), not in the 
overhang. To allow for alternating thick-
nesses, we create this roof as two stacked 
Roofs.

6

7

3

1
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Thin Lines
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Double-click on the lower Roof 
to Edit Boundary.

9 Revit will ask you to pick a 
View - set to Level 1.

10 Align and Constrain the 
Roofs Boundaries to the edges 
of the living/dining room. Ex-
cept to the west - here, Align 
and Constrain to the external 
face of the Curtain Wall.

Create Roofs without eaves
Go to Level 3.
Set Underlay to Level 1.
Create Roof by Footprint. 
Pick Basic Roof Generic - 
500mm.
Set Base Offset from Level 
to 0.

11 Draw a Roof over the kitch-
en and the bathroom. Create 
edges aligned to external fac-
es of Walls. Set only northern 
edge to Define Slope, and set 
Slope to 12.00°. Finish Edit 
Mode.

12 Go to Level 4 and create 
a similar Roof using the same 
settings.

10
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12
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Finalize connections
Set up a new WIP 3D Section 
View for inspecting the model 
from below.
Set the Section Box to cut 
away the Floor at Level 1. It 
may be an advantage to switch 
off Shadows.
Attach Walls to Roofs wherev-
er necessary.

13 The Curtain Wall west of 
the living area should be At-
tached to the lower Roof imme-
diately above it.

14 When Attaching, an Error 
may warn you that a the top 
Mullion of the Curtain Wall has 
to be deleted in the process. 
Accept this and create a new 

Mullion at the top.
Where no intersection lines 
between intersecting elements 
are visible, Join the elements.

In the process, it can be neces-
sary to adjust the Views Sec-
tion Box to get a close enough 
view in different locations of the 
model.

13

14
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2

4

Copy and Paste Doors
Go to Level 0.

1 Select Doors to be placed in 
identical positions on Level 2 
(mezzanine level).
Hold down CTRL while press-
ing C (CTRL+C) to Copy them 
to the computers clipboard.
Go to Level 2.

2 Insert the copied Doors in 
the right position immediately 
this way:
Tab Modify > Paste (from clip-

board) > Aligned to Current 
View.

Copy and Paste Windows
Go to Elevation 3.

3 Select Windows on Level 0 
to be placed in identical posi-
tions on Level 2.
Hold down CTRL while press-
ing C to Copy them to the com-
puters clipboard.

4 Insert the copied Windows 
on the right level in the right 

position immediately this way:
Tab Modify > Paste (from clip-
board) > Aligned to Selected 
Levels.

5 Select Level 2.

Create corner glazing
Go to Level 2.
Start creating an embedded  
Curtain Wall.

6 Set it to have Unconnected 
Height of 2400.

PROCEDURE/ Placing apertures

Apertures
Some aperture elements to be inserted on 
the upper Levels are identical to the ones 
on the lower Levels, and should be posi-
tioned exactly above.
It is easy to copy and paste Elements from 
one Level to the same position on anoth-
er, using the Paste Aligned to Selected 
Levels or Paste Aligned to Picked Level 
tools.

Other aperture elements must be modeled 
from scratch.
For corner Windows, common Window 
Families can not be used.  Predefined Cor-
ner Window Families may exist, but are not 
available in the BIMbogen template.
Instead of spending time setting up a new 
Family at this stage in the project, we will 
make use of the freedom of design when 
working with Curtain Walls.

Copy to clipboard

Paste Aligned to 
Current View

Paste Aligned to 
Selected Levels

1
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7 Draw first a part embedded 
in the southern external Wall, 
clockwise all the way to the 
Wall corner.

8 Set rebate depth to 50.

9 Set up this Curtain Wall with 
Mullions, an Empty Pane and 
a square Mullion towards the 
Wall corner, exactly like when 
you created the glazing at the 
entrance.
Go to Level 2 again and create 
another Curtain Wall according 

to the revised plans on page 1 
of the Reference Sheet.

10 Go to Elevation 2 and 
create Curtain Wall Grid and 
Mullions as shown. For the 
hinged frame, Select the Cur-
tain Wall Pane (use the TAB 
key) and change its Family to 
CW Single-Light. 

11 Set up a new Type, name 
it CW Single Light - Broad and 
change its Thickness to 80.

Remaining apertures
Insert and adjust the remaining 
Doors and Windows according 
to the revised plans and eleva-
tions in the Reference Sheet.

12 These are the Properties 
of the two Windows at Level 3 
in the south facade.

13 If some Windows are not 
visible in the View Level 3, click 
View Range in View Proper-
ties and adjust as shown.
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2

In Revit, Stairs and Railings can be creat-
ed with a high degree of automation. Like 
it is the case with many other features in 
Revit, to gain the full benefit of automation, 
freedom of design is somewhat restricted.
Revit operates with two Stair tools:
Stair by Component and Stair by Sketch.
Stair by Component is the fastest and eas-
iest for common stairs. This tool creates 
Stairs consisting of Runs, Landings and 
Supports.

Stair by Sketch is best for custom made 
and special stairs. This tool converts a 2D 
sketch to 3D stairs.
Stairs created by Component can be con-
verted to Stair by Sketch - not the opposite.

Railings in particular is a heavily parametric 
Category, of which it can be hard to control 
the design visually without some practice.
In Chapter 4.4, a short introduction to 
Stairs were made. Here, different Families 
and Sub Components are described.

File: Revit Case Study 5.4 p74

Preparations
Go to Level 1.
Move WIP Section 2 to cut the 
internal Stair. Orientate it to 
view towards the south.
Double-click on the internal 
Stairs to Edit it.

1 Now inside the Stairs, Se-
lect the Run. Adjust its width 
to 1000, make sure its north-
ern end is still is Aligned to the 
Wall. Finish Edit Mode.

Set up Stair Type

2 From the Architecture Tab, 
Start the Stair by Component 
command.

3 In Type Selector, Duplicate 
a Type from the Cast-In-Place 
Family and set up as shown.

Notice, when clicking to adjust 
the Landing Type, the Type 
Properties of the Landing 
opens.

4 Here, set up a new Landing 
Type with Thickness 200 and 
click OK to get one level up, 
back to the Stair Type.

5 In the Options Bar, set Lo-
cation Line to Run: Left and 
Run Width to 1000. Tick Auto-
matic Landing. 

6 Notice in the Properties, 
the Stairs are set to span from 
Level 1 to Level 2. Change Top 
Level to Level 3.

PROCEDURE/  Creating the main stairs

5.4/ STAIRS AND RAILINGS

Stair by Component

1
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We will create the main stairs consisting of 
two Runs and two Landings.
Both Runs will be created using Stair by 
Component.
For the Landings, one will be created au-
tomatically and the other will be drawn by 
sketch.

Main stairs

Create Stairs

7 Click here to start drawing 
the Run.

8 Notice that the number of 
steps created and remaining is 
seen while drawing.
Click to finish drawing the first 
Run at 10 steps.

9 Click here to start drawing 
the second Run.
Click to finish the second Run 
at 0 remaining.

Modify and create Landings

10 Notice that a Landing con-
necting the two Runs is gener-
ated automatically.
Notice also that we are still 
working in the Stair - the rest of 
the model is grayed out.

11 Select the Landing and 
Drag its edge to align to the 
Wall face - do not use the Align 
command, as this would cause 
the Run to be relocated.

12 Drag this Control to Align 
to the Door edge to the north.

13 The stair should now look 
like this. Do not Finish Edit 
Mode.

Run
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Go to Level 3.

14 From the Contextual 
Modify Tab, create a Landing 
Component.

15 Pick Create Sketch.

16 Now sketching the Land-
ing, pick the Rectangle tool 
and draw the Landing like this. 
Constrain its edges to the Wall 
edges.

Finish Edit Mode to exit the 
Landing.
Now we are back in the Stairs 
Edit Mode.

Review Stairs
Go to WIP Section 2.

17 The lower Run needs to 
connect to the Floor. Select the 
Run.

18 In the Runs Instance 
Properties, set Extend Below 
Riser Base to -200.

19 The Run should now look 
like this.
Finish Edit Mode.

Notice that Railing is gener-
ated automatically. Select the 
Railing and Delete it - we will 
create a new to control its ge-
ometry in detail.

Landing

Rectangle
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Prepare Views
Go to Level 1.
Select all internal Stairs and go 
to (3D).  The Stairs will still be 
selected.

1 In the View Control Bar, 
click Temporary Hide/Isolate 
> Isolate Element to see only 
the Stairs.

Set up Railing Type
Go to Level 1. 

2 In the Architecture Tab, 
start the Railing > Sketch 
Path command.

3 In the Type Selector, pick 
900mm, Duplicate and name 
the new Type 900mm Round 
Profiles. Set Baluster Offset 
to 20. Click OK. 

4 Click Baluster Placement 
and set up as shown. Click OK.

5 Click Edit Rail Structure 
(Non-Continuous). Set Offset 
of Rail 1 to 20 and choose a 
Circular Handrail: 40 mm.

PROCEDURE/ Placing Railings

Railings
Railings in Revit can be hosted by Stairs, 
Floors or Ramps - or they can be 
free-standing, associated with a Level.
Railing consist of the sub-components 

Rails and Balusters, evenly spaced along 
the Path of the Railing, distributed accord-
ing to rules set up in the Railing Type.

Temporary Isolate

Railing - Sketch Path

Baluster Placement

1
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6

5

4

3

2 1

Create Railing I

6 Draw 5 segments - it should 
have exactly the Line segments 
and dimensions shown.
Go to (3D).

7 In the Contextual Modify 
Tab, tick Preview to see how 
the Railing would look if fin-
ished now.

8 The Railing will probably look 
like this.

9 To let the Railing be Hosted 
by the Stairs, go again to the 
Contextual Modify Tab, Pick 
New Host and click on the 
Stairs.

10 Now the Railing should 
look like this.

For security and a smoother 
course of the handrail, the hor-
izontal parts should be posi-
tioned higher.

11 To adjust their height, Se-
lect one of these three Line 
segments.

12 In the Options Bar, set 
Height Correction to Custom 
height: 100.
Do the same for the two other 
segments, one at the time.
Finish Edit Mode.

13 The Railing should now 
look like this.
The Railing should be posi-
tioned above the Stairs. If this 
is not the case, Select it and 
click the Flip Control (double 
arrow).

Create railing II
Create Railing for the Stairs to 
Level 0 in a similar way.

Edit Rail Structure

Pick New Host
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File: Revit Case Study 5.5 p79

Furnish upper floors
Go to Level 0. Select furniture 
to be copied to Level 2 and 
Copy to clipboard (CTRL+C).
Go to Level 2.

1 In the Modify Tab, click 
Paste > Aligned to Selected 
Levels. Rearrange furniture 
in Plan and insert more as re-
quired.

Go to a WIP 3D Section View 
and adjust to see into rooms at 
the upper Floors.
If furniture is floating in the air, 
it is not placed on the correct 
Level. It can be placed on the 
correct Level using the Pick 
New Host command and click 
ing on the floor of the proper 
Level..

Set up Options

2 To set up alternative fur-
nishing Options, click on the 
Design Options icon in the 
Status Bar or tab Manage > 
Design Options.

PROCEDURE/ Setting up alternative furniture Plans

5.5/ DESIGN OPTIONS
To document the flexibility of the layout, we 
will set up two different furnishing options.
In Revit, multiple alternative designs can 
coexist in the same model. This can be 
practical not only for different furnishing 
options like here, but also e.g. different par-
titioning can be kept in the model.
A View can be set up to show a certain Op-
tion - this will be explained further in the 
book.

Overruling direction constraint
Some Components - furniture etc. - snap to 
horizontal or vertical directions when being 
Moved. To overrule this, hold down the SHIFT 
while moving.

Design Options
Design Options are parallel virtual realities in 
the project.
Options can be activated and deactivated - 
the simplest way to do this is through the pan-
el in the Status Bar.
An Option can contain Elements. If an ele-
ment is contained within an Option, it is only 
present in the project when this Option is ac-
tive.
Objects can be moved or copied between Op-
tions.
To work with Options, a Set of Options must 
first be created. Within this, any number of 
alternative Options can be created. One op-
tion is primary - it will be present in the project 
unless another Option in the Set is activated.
In the Status Bar you can control whether ele-
ments in Options are selectable or not.

Copy to Clipboard

Paste Aligned to 
Selected Levels

Design Options

1

2
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3 In the menu appearing, click 
New Option Set. A Set with 
one Option so far (the Primary 
one) is now created. Rename 
the Set to Furnishing Options.

4 Create another Option in the 
Set by clicking New Option.
Name the Options Furnishing I 
and II. Close the dialog box.

Add elements to Options
Go to (3D) and Select all ob-
jects.

5 By filter, isolate the Category 
Furniture to be Selected only.

6 In the Status Bar, click Add 
to Set.

7 In the box appearing, tick 
both boxes in order to add all 
Furniture to both Options.
Now the two Options contain 
identical elements.

8 Activate the non-primary 
Option Furnishing II. Only the 
furniture contained here will be 
seen.

Add to Set

3

4

5

6

7

8
9
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10

10

1113 12

9 Elements not in the Option 
can not be edited while the 
Option is active, unless Active 
Only is unticked.
Go to Floor Plan and rearrange 
some furnitures to alternative 
positions. Delete furniture and/
or insert new as you see fit.
If several pieces of furniture 
has been Grouped together 
(e.g. dining table and chairs), 

they have not been included in 
the Option.

10 Uncheck Active Only and 
Select the dining group. 

11 Click Add to Set.
Finalize arranging the furniture 
on both Levels. 

12 Return to Main Model via 
the Status Bar.

13 Click Design Option to 
open settings.

14 Furnishing I is set to be 
Primary and objects will be 
visible in all views

15 If you want to have ob-
ject from Furnishing II visible, 
select Furnishing II and click 
Make Primary.

Figure 5.5.1
Different Design Options within the same Revit file
Design Option Furniture I

Figure 5.5.2
Design Option Furniture II

14

15

Make Primary
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3

Figure 5.5.3
Ground Floor Plan with Furnishing I
Design Option applied

Figure 5.5.4
Ground Floor Plan (Alternate) with Furnishing II 
Design Option applied

Apply Option I

1 Go to Ground Floor Plan. 

2 In Properties click Edit on 
Visibility/Graphics Overrides. 

3 On the Design Options Tab 
choose Furnishing I (Primary) 
from the drop-down. Nothing 
really changed because the 
Primary Design Option is al-
ready visible in all Views.

Duplicate View

4 Create a copy of Ground 
Floor Plan. Right-click and Du-
plicate View > Duplicate With 
Detailing to duplicate not only 
the model, but also Annotation.
Name the new view Ground 
Floor Plan (Alternate).

Apply Option II
Apply Furnishing II to Ground 
Floor Plan (Alternate).

Create a new Sheet and drag 
Ground Floor Plan (Alternate) 
on to it.
Create a drawing showing al-
ternative furnishing of the up-
per Floor Plans using the same 
method.

Before, we set up two different furniture 
arrangements, using the tool Design Op-
tions. To display both options in the project, 
we need to set up a set of alternative Floor 
Plan drawings, showing the alternative fur-
niture arrangement.

In Revit, a View can be set up to display 
certain Design Options.
We will now create a new View of each 
Floor Plan and assign the alternative 
(non-primary) Option to each of them.

PROCEDURE/ Setting up Floor Plans with alternative furnishing

Alternative furnishing on Sheets

1

2

4
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Wall recess
Go to Elevation North.

1 In the Tab Architecture, 
click Component > Model In-
Place.

2 Pick Category Walls.

3 Name the Model Recess 
North Facade.

4 Now modeling in the In-
Place Editor, click Void Forms 
> Extrusion.

5 Click on Pick a Plane. Click 
OK and select an external face 
of a Wall in the facade of the 
tallest part of the building.

6 In the Options Bar, set 
Depth to 50.

PROCEDURE/ 3D detail finishing

3D detail finishing

5.6/ FINISHING THE MODEL
Adding 3D detailing to the project is the fi-
nal modeling action before setting up the 
project to generate output.
After this, there will be some more 2D de-
tailing to do, finalizing surfaces with materi-
als to control their visual appearance.

- Is small model elements like gutters, drain 
pipes, roof profiles, wall recesses, sweeps 
and reveals.

Some of these are predefined Revit fam-
ilies, and some must be custom-made in 
a project, downloaded or acquired in other 
ways.

Model In-Place
To create freely shaped elements or gener-
ic geometry, the tool Model In-Place can 
be used (‘In-Place’ as opposed to creat-
ing Family files and loading them into the 
model). Here, generic geometric tools are 
available to create Extrusions, Revolves, 
Sweeps or Composites of these.
Models created In-Place must have a Cat-
egory assigned - Wall, Windows etc. They 
can be created as Solids or Voids. Voids 
can be subtracted from solid geometry, like 
in the example below.

1

2

3

4

5

Model In-Place
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7 Draw rectangles between 
the Windows. Constrain the 
edges. Finish Edit Mode.

8 Back in the In-Place Model, 
start the Cut Geometry com-
mand. Watch the Status Bar. 
Pick the Void and the Wall 
above, then the Void and the 
Wall below to subtract the Void 
from both Walls. Finish Model.

Fascia Boarding
Go to (3D).

9 In the Tab Architecture, 
click Roof > Roof: Fascia. Se-
lect Type: Fascia 25x250mm.

10 Click on the upper edges 
of the ends of the southern 
Roof with eaves to add Fascia 
Boarding. Flip by Flip Control 
to cover the Roof ends.

11 Select the boarding - in the 
Contextual Modify Tab, click 
Modify Mitering...

12 ... and set to Perpendicular. 
Click on both lower ends.

Cut Geometry

Roof: Fascia

Modify Mitering

8

10

6

9

11

12

7
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Parapet profile

13 In the Project Browser, 
expand the groups Families > 
Profiles. Right-click Fascia - 
Flat and pick New Type.

Name it 5x60mm. Right-click 
the new Type, pick Type Prop-
erties.

15 Set dimensions according 
to the name.

16 Start the Fascia command 
again and set up a new Type 
named Parapet 5x60mm.
Set Profile to the one just cre-
ated.

17 Click on all the upper edg-
es of the Roofs with no eaves 
- and the upper edges of the 
Fascia created before (Fascias 
can host Fascias). Flip. 

13

15

17

17

16

Profiles
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Gutters I
Go to (3D).

18 In the Architecture Tab, 
click Roof > Roof: Gutter. Set 
up a new Type named Gutter 
-  Round.

19 Set Profile to Gutter_
Round: ø120. Click OK.

Click on the horizontal edge of 
the southern Roof to place the 
Gutter.

Gutters II
Go to Elevation East.

20 To create gutters embed-
ded in the Roofs with no eaves, 
start the Model In-Place com-
mand.

21 Pick Category: Roofs and 
name the Model Gutter - Em-
bedded 1. 

22 Start creating a Void Ex-
trusion. To select a Plane, 
click on the face of the Wall 
with the entrance Door (use 
TAB if necessary).
Set Depth to any value - we 
will adjust afterwards.

23 Draw profile as shown.
Go to Elevation North.

24 Set up a Ref Plane 240 
mm from inside the Wall end, 
Pin the Ref Plane and Align 
and Constrain the Void to here.

Subtract Void from Roof, using 
the Cut Geometry command.
Finish Edit Mode.
Create an embedded gutter in 
the upper Roof in a similar way. 
Tip: Go to Elevation 4, copy the 
Void used before in position, 
go to Elevation 3 and adjust 
ends.

Roof: Gutter

18

19

20

21

22

23

24
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Drain Pipes
Go to Level 0.
Start the command Compo-
nent. In the Type Selector, pick 
Downpipe w. Angle - Generic - 
Wall Hosted 75 mm Pipe.
Click on Wall to place the Com-
ponent.

25 Relocate here.
Go to Elevation West.

26 Select the Drain Pipe and 
adjust Instance Properties 
approximately as shown.

27 The Drain Pipe should look 
approximately like this.

Go to Elevation South.

28 With the Pipe selected, 
start the Mirror - Draw Axis 
command. In Options Bar, tick 
Copy. Click on the midpoint of 
the Roof. Drag up and click to 
specify the mirroring axis in 
order to Copy the Pipe into the 
right position.

Component

Drain Pipe

Mirror - Draw Axis

26

27

28

25
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Place Plantation
Go to Site.
Go to the Tab Massing & Site 
and start the command Site 
Component to place proposed 

new Plantation. Distribute as 
wished or approximately as 
shown.
Duplicate Types to create vari-
ation in heights. Rotate ‘ran-

domly’ to avoid repetitive visual 
appearance on output eleva-
tion drawings.

PROCEDURE/ Landscaping

Propose landscaping
A proposal for new landscaping elements 
is a part of the design proposal.
In this case study, this will be exemplified 
only by placing Plantation.
The choice of 3D Plantation elements 
available in the DanEDU setup and in the 
BIMbogen template is limited. To supple-
ment it, you can try to browse free internet 
sites for hedges etc.
Notice however, that adding many land-
scaping elements with a high degree of 3D 
detail to the model can make the file size 

grow and burden the graphic memory of 
your computer, slowing down the real-time 
response while working.
Therefore, if working with large sites with 
many site elements, it is good practice to 
keep terrain and site elements in a sepa-
rate Site Model linked into the Building 
Model.
In general, it is also best to keep the detail 
level of the site components used at an ab-
solute minimum.

5.5.1 Proposed Plantation
Red ash along northern site boundary.
Hawthorn along southern site boundary.
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Assign Wall Material
Go to (3D).
Select an external Wall and 
Edit Type. Duplicate and 
name new Type Generic - 
480mm (Exterior) w. Brick Ext.

1 Edit Structure and click In-
sert to add a Layer.

2 Set up the Layers like this 
using Up and Down buttons. 
Remember to change Thick-
ness.

3 Click here to appoint another 
Material to the external Layer.

PROCEDURE/ Finishing and stitching the surfaces

Surface stitching and finishing
Finally, we will add symbolic hatching to 
surfaces to indicate materials, using Fill 
Patterns.
At this stage, materials may not be decided 
for in detail, so we will keep the representa-
tion of materials on a generic level.
It is assumed that brick has been finally 
agreed for the external Walls, so we will 
show generic brick courses.
To do this, we will edit the Structure of the 
Walls, adding a layer. This is done only to 

arrive at a certain visual expression and 
not to specify the assembly of the Walls 
yet, as this is not to be specified at this 
project stage.
Some model ‘stitching’ is required in or-
der to achieve visually seamless surfaces. 
Here, the Revit commands Join and Un-
join are used.

1

2

3
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4

5

11

9

6

7

8

11

10

4 In the Material Brows-
er appearing, scroll to Brick, 
Common  - or type Brick in the 
Search field at the top.

5 At Surface Pattern, click on 
Pattern.

6 Click for Model Patterns 
(non-symbolic Patterns with 
fixed dimensions).

7 Select Horizontal 100mm 
and click Duplicate.

8 Set up and rename the new  
Fill Pattern as shown.

9 Set color to Black.
Click OK > OK > OK.

10 Select one of the other Ex-
ternal Wall in the project, Right-
Click and Select All Instances 
In Entire Project.

11 In Properties select Ge-
neric - 480mm. (Exterior) w 
Brick Ext.

12 Only External Wall Fac-
es have the Pattern - not Wall 
ends and rear faces of exterior 
Walls.

13 To assign it to other Wall 
faces, start the Paint com-
mand in the Modify Tab. In the 
Material Browser, make sure 
that Brick Common is selected.
Navigate around the building 
and click on Wall faces to Paint 
them.

Surface Pattern

Material Browser
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14 Also the Roof edges 
should be brick - Paint these.

15 Select this Wall and Tem-
porary Isolate it.

16 Paint the brick Material on 
all the faces of the Wall - also 
the interior face.

Reset Temporary Isolate.

Stitch wall faces

17 To ‘stitch’ the facades and 
eliminate the intersection lines 
between two elements with the 
same material, Join them.
If faces are already joined but 
still seem divided, make sure 
they are absolutely aligned.

18 If this does not help, start 
the Unjoin command and click 
on one of the elements to Un-
join it from all other elements, 
and start over, Joining them 
again.

12

14
14

14

13

18

12

17

1717

15

16

12
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Now the model should look like 
in Figure 5.5.2.

Assign Roof Material
Go to Site.
Select the top Roof, Edit Type, 
Duplicate and name it Generic 
- 500mm w. Roofing Felt.

19 Set up the Roof with a thin 
external Layer.

20 Make sure the total thick-
ness of the Roof stays the 
same as before.
For the external Layer, assign 
the Material Roofing Felt.

21 Set up Roofing Felt with a 
Fill Pattern like shown.

Finish setting up the Roof Type.

Select the Roof over the kitch-
en and change its Type to the 
same as the top Roof.

Use the same method to set 
up a new Roof Type (thickness 
250 mm) for the  external Roof 
over the southern part of the 
building.

19

21

Figure 5.6.2
Model progression at this stage
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22 The Roofs will probably 
look like this - the Patterns is 
uneven.

23 Relocate the Fill Patterns 
on the Roofs to center the lines 

on each Roof (e.g. like shown). 
To Select a line in the Fill Pat-
tern: Hold the cursor still over 
the line, press TAB and click to 
Select.

Once a line in the Fill Pattern is  
Selected, the whole Fill can be 
relocated using any modify tool 
(Move, Align, Rotate etc.).
The result should look like Fig-
ure 5.5.3.

22 23

Figure 5.6.3
Roofs Fill Pattern aligned to each other
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Remaining Materials
Go to Level 1.
Select the southern terrace. 
Edit Type and Duplicate. 
Name the new Floor Type Ge-
neric - Wood 120mm (Exterior).

24 Set up a new Material for 
the new Floor Type based on 
the Material Timber, C24.

25 Set up Fill Pattern as 
shown.

Assign also a new Floor Type 
for the two remaining terraces.

26 Set up a Concrete Materi-
al for the Floor Type as shown, 
based on the Material Con-
crete, Broom Finish.

27 Set up Fill Pattern as 
shown (see next page).

Finish setting up the Material.
The Fill Patterns may not be 
oriented the right way.

28 To adjust the orientation 
of the Pattern, hold the cursor 
over a line in the Pattern and 

24

25

28
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26

27

press TAB to Select the line. 
This can now be Rotated like 
any other object, using the Ro-
tate tool.

29 Adjust the Pattern to look 
like this. Use Align or Move to 
relocate Pattern lines.

30 Adjust the Ramp at the 
entrance to follow the lines in 
the Pattern (without making the 
ramp or the platform outside 
the entrance door smaller).

31 To do this, Select the Floor 
and Modify Sub Elements. 
The points in the corners of the 
ramp can now be relocated, 
using the Move command.

29

31

30
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FINAL DRAWINGS 6
The conceptual design of the building is now assumed to be in place, and mod-
eling work is finished. What remains to be done is to generate the final drawings.
In general, these are set up by adjusting the preliminary drawings set up in chap-
ter 3.

At this stage, a semi-advanced level of Revit skill is assumed.
Though a few new Revit tools will be described, the main part of this chapter is 
about refining techniques and routines already introduced, or offering methods 
that alternate slightly from previously applied methods.
Routines that have been introduced previously will be considered basic know-
ledge, and will therefore not be described in detail.
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6.1/ REVISING DRAWINGS
After the first preliminary drawings were 
generated, detailed site information is 
added to the project, and the project has 
changed drastically. Therefore, each draw-
ing needs to be reviewed individually to 
make sure that all relevant information is 
included.
Also, for generating the final concept de-
sign drawings, a slightly higher level of de-
tail is introduced.
Some general issues to observe when re-
vising drawings are listed in the table to the 
right. Apart from following the procedures 
described in the following, it is a good idea 
to check all the points in the list for each 
drawing.

Figure 6.1.1
Stages of the development in chapter 6.1

2. More context and detail shown in the facade elevations.

•	 Estimate the range of drawings. 
Remove/add if necessary

•	 Review View Cropping and Sheet 
size

•	 Review View Range
•	 Review object visibility - Hide/Un-

hide if necessary
•	 Review model information - add 

/modify 2D linework if necessary
•	 Review annotations - add/modi-

fy if necessary
•	 Review graphics: Line Weights, 

Patterns, Shadows, Backgrounds. 
Add/modify if necessary

OVERVIEW/ Revising drawings

1. Information about terrain and surfaces shown in 
the Location Plan. Contours of the building added.
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In two plan drawings, visual indication of 
lines not directly visible in the View must 
be shown with a dashed line:  In the Lo-
cation Plan, the contour of the perimeter 
of the building below the Roof should be 

seen, and in the Ground Floor plan, the 
contour of the roofs and overhangs and 
roofs above should be visible.
We will draw them manually in 2D, using 
the tool Detail Line.

Figure 6.1.2
Location Plan with contour of the building perimeter

Figure 6.1.3
Floor plan with roof and overhang contours

Wall and Roof contours (Detail Lines)

UnderlayFile: Revit Case Study 6.0 p99

1 Go to Project Browser > 
Sheets > A.00 - Location Plan 
and activate Floor Plan: Loca-
tion Plan. 

Draw Detail Lines

2 We cannot see through the 
roof. Set Visual Style to Wire-
frame.

3 Go to tab Annotate > Detail 
Lines and draw lines with Line 
Style Overhead on the external 
wall face.
Reset Visual Style to Hidden.
See Figure 6.1.2.

Add underlay

4 On the Ground Floor Plan 
we would like to see the con-
tours of the roof edges.
In the Project Browser, go to 

Sheets > A.10 - Ground Floor 
Plan and open Floor Plan: 
Ground Floor Plan. 
In Properties, set Underlay to 
Level 2. This will make the Roof 
edges visible.

Draw Detail Lines
Draw Detail Lines on the Roofs 
edges using Line Style Over-
head. See Figure 6.1.3.
Set the Underlay back to None 
when finished.

2

3

PROCEDURE/ Adding contour lines

4
1
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Stair Path

North Arrow

1

2

Figure 6.1.4
Location Plan adjustment

1

PROCEDURE/ Adjusting the Location Plan

Stair Paths

1 Stairs are by default shown 
with an UP symbol. Select the 
UP symbol and uncheck Show 
Up Text. Do this on both stairs.

Slope indicator

2  Draw two Detail Lines on 
the sloped floor outside main 
entrance to indicate that this is 
a ramp. Use Line Style Hidden. 

North arrow

3 In Chapter 4.1, you discov-
ered that north is not precisely 
0/360°. On Floor Plan  Location 
Plan, Orientation must be set 
to True North.
Check that the North Arrow 
symbol is straight up (0/360°). 
If not, Rotate it.

Location Plan adjustments

Most of the new information to be shown 
in the Location Plan is generated automat-
ically from the model. Only a few 2D lines 
needs to be added manually, and the north 
symbol must be adjusted.
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Sheet DataEdit Topography

4 Go to Visibility Graphic 
Overrides (VG) and open Mod-
el Category Topography Check 
that Primary Contours and Sec-
ondary Contours are On.

Edit Sun Settings 

5 Check that the sun/shadows 
settings are correct for the view. 
No view template is applied for 
the view, therefore click Edit 
Graphic Display Options.

6 Click Sun Settings.
Check that Solar Study is set 
to Still. The Preset Aarhus 01 
June 1400 is active.
Ground Plane at Level is un-
checked.

Edit Sheet Data

7 Go to Sheet Site Plan and 
set Phase to Concept Design 
2. Because this is a Project Pa-
rameter, it will be applied to all 
other Sheets.
Set Date to current date. This 
will only be applied to this 
sheet.

5

6

6

6

77

Figure 6.1.5
Location Plan updated

4

3
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Adjust Crop Region

1 Go to Project Browser > 
Sheets > A.10 - Ground Floor 
Plan and open Floor Plan: 
Ground Floor Plan. 

2  Click Show Crop Region. 

3 Drag the Controls to resize 
the Cropping to make sure 
everything is visible. 

4 Hide Crop Region again.

PROCEDURE/ Adjusting Floor Plans

Floor Plan adjustments

1

2 4

Figure 6.1.6
Adjusting Crop Region

3

Apart from adjusting the Ground Floor 
Plan, a drawing with the Floor Plan of the 
upper storeys need to be added to the proj-
ect.
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Hide Objects
Go through the Plan View and 
hide objects that are not rele-
vant:
•	 UP Symbol (stairs)
•	 Trees
•	 Elevation Arrows
•	 WIP Sections
•	 Etc.

5 Go to the Sheet A.10 
Ground Floor Plan. Since the 
building had grown because of 
the garden wall towards west, 
the paper size increase. Select 
the Titleblock and select a big-
ger one; 30x63.
Place the View so everything is 
inside the frame of the Sheet. 
See Figure 6.1.6.

Floor Plan - upper levels
Set up a new sheet showing 
the upper levels, using meth-
ods introduced previously.

5

Figure 6.1.7
Ground Floor Plan after adjustment
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Overriding Cut Pattern

1  Go to Project Browser > 
Sheets > A.20 - Sections and 
open Section A-A. Turn on 
Crop. Resize Crop and hide 
Crop. Edit View Template 
Concept Design 1 - Sections.

2 Click V/G Overrides Model.  
While holding the CTRL select; 
Floors, Roofs, Stairs, Walls and 
click Override.

3 Set the Override Color to 
Black and Pattern to Solid Fill. 
The Coarse Fill will now be set 
to black in the four Categories.

1

2

PROCEDURE/ Adjusting Sections

Section adjustments

Like previously discussed, we optimized 
Views to display cut faces of building ele-
ments in black at the stage of concept de-
sign.
For the preliminary drawings generated in 
chapter 3, two methods were introduced: 

•	 Controlling Cut Pattern by Type by set-
ting Coarse Scale Fill to black in Type 
Properties.

•	 Controlling Cut Pattern by View Tem-
plate

While the former method is slightly more 
simple, we will prefer the latter from this 
point, as it makes it easier to make chang-
es.
Here, it is assumed that a View Template 
for the output Sections is already set up. 
Some changes need to be made to this 
Template, so it also controls the Cut Pat-
terns of relevant building elements.

3
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Spot ElevationSpot Elevations

4 To add Spot Elevations, go 
to tab Annotate > Spot Eleva-
tion. Set Type to Spot Eleva-
tion (Project).
If you prefer to add Spot Ele-
vation relative to the Survey 

Point, set Type to Shared in-
stead.

5 Add Spot Elevation to key 
points on Section A-A.

6 Make the same corrections 
to Section B-B.

Edit Titleblock

7 Select the Title Block and 
select the Sheet size used be-
fore.

4

4

7

5

6

Figure 6.1.8
Sections arranged on Sheet
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Adjust Crop

1  Go to Project Browser 
> Sheets > A.30 - Facades 
South & West and open Ele-
vation: South Facade. Turn on 
Crop. Resize Crop and hide 
Crop again. Note that the El-
evation Line cuts the garden 
wall. 

2 Go to Level 1 and select 
West Elevation Line. Move it to 
a position outside the garden 
wall.

Adjust visibility

3 Go to West Facade. Edit 
View Template Concept Design 

1 - Facades. Edit V/G Over-
rides Annotation. 

4 Uncheck Section visibility 
to hide all section lines on all 
facades.

2

4

PROCEDURE/ Elevation adjustments

3

Figure 6.1.9
South Facade before adjustment

Elevation adjustments

1

Like it was the case for the Sections, we 
will control as many settings as possible 
via View Template for the facade elevations 

also, in order to automate adjustments as 
much as possible.
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11

Adjust Background

5 Still in the View Template, 
click Edit Background to set a 
blue color as the sky:

6 Click on Gradient as the 
Background.

7 Click on Sky Color.

8 Set the Red, Green & Blue 
(RGB) to e.g. 146-162-172.

9 Set Horizon Color to e.g. 
248-249-252. and Ground 
Color to White.

10 Check that Lighting is set 
to In Session Lighting on all 
Output facade Elevations.

Administrate Sheets

11 We will adjust each Sheet 
to show only one facade El-
evation. Right-click on one of 
the Elevation Viewports on the 
Sheet. Select Remove from 
Sheet.
Create new Sheets and place 
the Elevations on the Sheet. 

5

6

7

9

9

8

Figure 6.1.10
South Facade after adjustment

10

Background - Gradient



108 6 documentation II - FINAL DRAWINGS 

Create New Camera

1 Create a new Camera show-
ing the building seen from 
south-east. Go to Level 1 and 
tab View > 3D View > Camera. 

2 Place the camera and set 
the target point.

Adjust Camera

3 Rename the new perspec-
tives Exterior South-East.
Go to Level 1. In the Project 
Browser right-click on a 3D 
Camera view.

4 Select Show Camera. You 
can then move the camera to a 
new position.

5 Or drag the target point to 
change the view direction.

6 Edit Far Clip Offset (dis-
tance to where elements be-
come invisible) and set Eye 
Elevation and Target Elevation 
(measured from Level 1)

2

1

5

PROCEDURE/ Generating Perspectives

Perspectives

3

6

6

4

Figure 6.1.11
Perspective south-east before adjustment

Camera

Due to the project changes, the visual ap-
pearance of the building has changed thor-
oughly. Therefore, we need to reconsider 
which Perspective Drawings to include in 
the project.
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Adjust Background

7 Go to the Perspective  
South-East. In the View Tem-
plate set Sky Background to 
Gradient and adjust the Back-
ground colors as on the Output 
facade Elevations.

8 Select the Viewport  to Scale 
(Locked Proportions). Adjust 
the Model Crop Size to Width 
400 mm. Hide the Crop.

9 Try out different lighting set-
tings for each view.

7

9

8

Figure 6.1.12
Perspective south-east after adjustment
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2

3

5

4

6.2/ GENERATING OUTPUT

Create Sheet List

1 On the View Tab select 
Schedules > Sheet List.

2 Select a Field to be added to 
the Sheet List.

3 Click on Add.

4 Add these five Fields to the 
list in a random order (include 
Sheet Issue Date). 

5 Order them by selecting a 
field and then select Move Up 
or Move Down. 
Click OK to finish.

6 First impression of the Sheet 
List.

7 In Properties click Edit Fil-
ter. This will open the Sheet 
List Properties again. 

PROCEDURE/ Generating a Sheet List

1 6

7

For a general overview of the drawings 
included in the project, we will generate a 
Sheet List. For this, a new View Family is 
introduced: Schedules.
Schedules are Views of the Building Mod-
el, displaying alpha-numeric information  
organized in data sheets (much like Mic-
rosoft Excel or similar software) instead of  
geometry.

Any Parameters existing in the project can 
be displayed in sheets: Window dimen-
sions, Wall Areas, Room Areas etc.
In the later project stages, this will find a 
wide range of possible applications, and is 
at the core of the potential benefits of BIM 
method.
In this example, we will create a complete 
list of Sheets in the Project.

Schedules

Sheet List

Sheet List
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Edit Sheet List

8 We only want to have Sheets 
in the list beginning with the let-
ter A (we do not want to add the 
Splash Screen). Filter By: Sheet 
Number - Begin With - A.

9 The Sheet List should start 
with the lowest number (A.00 
- Location Plan). Click on the 

Sorting/Grouping Tab. Sort 
By: Sheet Number - Ascend-
ing.

10 On the Formatting Tab 
you can adjust the headings 
(Scale instead of Written 
Scale).

11 Appearance Tab control 
borders and text in the list. 

Changes will only be visible 
when Sheet List is placed on a 
Sheet. Click OK to finish.

12 The last three Columns are 
writeable fields. Note that once 
you have written something in 
a field, it can be selected by the 
drop down. 

8

9

11

10

Sorting/Grouping

12
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Export type

1 Go to Application Menu > 
Export > DWF/DWFx. 

What to Export?

2 On the Views/Sheets tab 
and Export menu, select 
<in-session view/sheet set>

3 In the Show in List menu se-
lect; Sheets in the Model.

4 In the Include column, 
check the Sheets you want to 
export.

Export DWF

1 4

2

3

DWF™ is Autodesk’s method of publishing 
design data. It allows for an easy-to-handle 
3D model to be distributed for reviewing. For 
2D Views, it offers an alternative to printing 
to PDF.
Software for viewing a DWF file containing a 
3D model and/or 2D Views is free, but not as 
widespread as PDF viewing software.

Like PDF, DWF is a locked file format, but  
there are a number of advantages such as:
•	 Measure. Snap to objects.
•	 Mark Up. Add comments for design 

changes etc.
•	 Object Info. Quantities and areas.
The file size of DWFs is small compared to 
Revit project files, making it easy to distribute 
by email.

Export to Design Review

PROCEDURE/ Exporting to Design Review
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Export Settings

5 Select the next Tab; DWF 
Properties.

6 Click Print Setup. 

7 Set the Raster Quality to 
Presentation. Click OK.

8 Click Save As to save the 
settings for future DWF Export.

Save DWF

9 Click Next... and save the 
DWF on your computer.
If the exported file fail to open 
when you double-click it, you 
probably need to install a free 
copy of Autodesk Design Re-
view on your PC.

7

8

5

6

9
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Appendix: the context

SITE

The surroundings of the building are important design parameters.
In order to deal with these and let them inform and enrich the project, it is necessary to feed 
the project with information.
This appendix is dealing with setting the context. We will create a Site Survey model, con-
taining the most relevant information regarding the existing conditions:

•	 Location - the whereabouts in the world
•	 Orientation - the corners of the world
•	 Terrain - elevations, slopes, height above sea level
•	 Landscaping - existing plantation etc.
•	 Existing buildings (if any)

Being able to see more accurately how the building is set in its surroundings may - and 
should - in turn affect the building design. 

In this appendix, two common alternative methods of establishing a Site Model in Revit are 
introduced:

A1: Generating a Site Model based on a digital 3D survey in AutoCAD format (.DWG) as 
often provided by for example a professional land surveyor.
A2: Modeling a Site Model based on a scanned hard copy survey or a screenshot from a 
web page (JPEG, PNG or PDF format).

Decide which of the procedures to follow, and start in either section A1 or A2.
Alternatively, try first the one method, then the other.
Following any of the two procedures, the result will be a Site Model of the existing conditions 
to be finalized in section A.3, and finally to be combined with the Building Model in chapter 4.1.

A
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•	 Set up Site Survey Model
•	 Link CAD file
•	 Generate Toposurface from link
•	 Generate Property Lines
•	 Generate Subregions

OVERVIEW/  Generating site 
from linked 3D CAD file

In this section, it is assumed that a profes-
sional digital CAD-file with site information 
is available. 
Most land surveyors will be able to supply a 
digital file in AutoCAD format (.DWG). Files 
from a surveyor will most often be format-
ted with units in Meters.

For the purpose of this exercise, a sur-
vey model named Revit Case Study SITE 
SURVEY CAD is supplied for download on 
BIMbogen.dk.
Before starting, download the file, unpack 
and save to your project folder.

A.1/  SITE FROM 3D CAD FILE
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1

Create new Model
Close any open Views to go to 
the Revit Home Screen (see 
Figure A.1.1).

1 Click on New > BIMBOGEN 
Building Template to create a 
new Project.
If your home screen does not 
display this Template, return to 
chapter 1.2 for instructions on 
how to add it.

2 In the File Tab, Save As a 
Project in your project folder, 
naming it ‘Revit Case Study 
SITE SURVEY’.

New Project

Save As

Set up the Site Survey Model

PROCEDURE/ Setting up Site Survey Model

2

Figure A.1.1
Revit Home Screen
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Link CAD
In Revit, go to the Project 
Browser and activate the Site 
View by double-clicking it.

1 In the Insert Tab, click Link 
CAD.

2 Browse to the folder where you 
keep the unzipped AutoCAD file 
Revit_Case_Study_SITE_

SURVEY_CAD and click on 
the file.

3 Set Import units to meter.

4 Set Positioning to Auto - 
Origin to Origin.

5 Set Place at to Level 1. 

6 Click Open to link the Auto-
CAD file.

Review link
In the Project Browser, open 
the {3D} View to see the con-
tent from the linked file. Check 
if the Contour Levels seem to 
be placed in roughly the correct 
Z-height. See Figure A.1.2.

2

3

4

5

6

Link CAD

PROCEDURE/ Linking AutoCAD file into Revit

1

Information flow within and 
across platforms
Like any other professional CAD-tool, Revit can 
handle communication across digital platforms 
as well as transfering information from one Revit 
file to another.
Some key concepts are:
EXPORT: To translate a Revit file - or a part of 
its information - to a new file with a format that 
can be handled in other Revit files or by other 
programmes.

IMPORT: To integrate information from a file 
formatted for use by Revit or other programmes 
into a Revit file.
LINK: To make information from another file - 
Revit or other - available inside a Revit Model 
by representation (not integration as when im-
porting).

Linking, Importing and Exporting information 
between different CAD-programmes and con-
verting between file formats native to different 
digital environments is a natural part of a mod-
ern BIM-workflow.
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Create toposurface

1 In the Massing & Site Tab, 
start the Toposurface command.

2 Click Create From Import > 
Select Import Instance. 

3 In the Drawing Area, click on 
the linked file.

4 Click Check None to dese-
lect all layers.

5 Select these two layers  
(holding the terrain contours) to 
generate the toposurface from 
them. Click OK.

6 Click Finish Surface.
 

Review Toposurface
Navigate to check if the topo-
surface has been generated as 
seen in Figure A.1.3.

PROCEDURE/ Generating Toposurface from link

Generate topography from linked file

Figure A.1.2
Linked CAD file

Figure A.1.3
Revit Toposurface

1

2

6

5 4

3

Toposurface, 
Create from 
Import

In Revit, terrain is modeled as a Toposur-
face - a surface defined by any number of 
points in three-dimensional space.
For further explanation and how to model 
it from scratch, see A.2/ Site from 2D file.
Revit can automatically generate a Topo-
surface from 3D topographical information 
in a linked file created in another CAD envi-
ronment, in this case from AutoCAD.
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5

6

5

5

PROCEDURE/ Generating Property Line from linked file

Preparations
Go to Plan View Site.

1 In the View Control Bar, set 
Visual Style to Wireframe. 

Sketch Property Line 

2 To define the boundary of the 
property, go to the tab Massing 
and Site and start the Proper-
ty Line command.

3 Select Create by sketching. 
You are now in Edit Sketch 
Mode and can use the drawing 
tools normally available here.

4 Create the Property Lines 
using Pick Lines. 

5 Click on these three lines.

6 To generate the Property 
Line along the road, hold the 
cursor over the boundary and  

click TAB to cycle through 
availible lines. When the 
boundary is highlighted, pick it.

7 Click Finish Edit Mode in 
tab Modify... the Property Line 
is now finished.

Area check

8 Select the Property Line. In 
Properties, check if the Area 
is roughly as expected.

Property Line

Generate more data from linked file

3

We will exploit further, that Revit under-
stands the linked material. This means that 
we can generate objects in  their exact po-
sitions from the survey file, without risk of 
imprecision and without losing data.
Here, we will use this to create the prop-
erty boundary and the road in their exact 
locations.
To show roads, sidewalks, paved areas or 

other differences in surfaces within a Topo-
surface, we use the tool Subregion to sub-
divide the Toposurface. 
A Subregion forms part of a Toposurface, 
but can be assigned its own properties, dif-
fering from the rest of the Toposurface.
The boundaries of a Subregion are defined 
in Edit Mode using the drawing tools nor-
mally available here.

2

1

47

8
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PROCEDURE/ Generating Subregions from linked file

Go to Plan View Site.

Sketch Subregions 

1 Go to the tab Massing and 
Site and start the Subregion 
command.

2 Again, select the Pick Lines 
drawing tool. 

3 Pick these four lines.

4 The Subregion must be a 
closed loop of lines. Pick the 
Line tool.

5 Move the cursor over this 
line end. Press TAB until END-
POINT shows in the display, 
then click to start drawing a line 
from here.

6 Hold the cursor over this 
endpoint and press TAB until 

ENDPOINT appears, then click 
to finish lthe new line here.

7 Repeat action in the other 
end.

8 Click Finish Edit Mode to 
finish creating the Subregion.

Proceed now to section  A.3.

1

2

4

3

3

3

3

5

6

7

8

Subregion
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•	 Set up Site Survey Model
•	 In plan view Site, insert image 

with site survey plan
•	 Adjust scale of inserted image
•	 Draw Property Lines
•	 Model 3D topography on top of 

inserted image
•	 Subdivide surface of terrain, 

showing hard surfaces, bodies 
of water etc.

•	 Add other existing site objects if 
relevant (buildings etc.)

OVERVIEW/  Modeling the site
In this section, it is assumed that no digi-
tal 3D information about the building sur-
roundings is available. This we need to 
establish ourselves, and in order to do so, 
we need to first establish reliable 2D infor-
mation within a Revit Model.

In many projects, a 2D land survey plan 
with information about point elevations, 
property boundaries, bodies of water, ex-
isting buildings and plantation etc. will be 
available, either obtained from web plat-
forms as image files, or in hard copy for 
scanning.

For the purpose of this case study, a sur-
vey plan is supplied as an image file for 
download from BIMbogen.dk.

A.2/  SITE FROM 2D FILE
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1

Figure A.2.1
The imported survey plan image

SITE 2D/ Import a survey map

PROCEDURE/ Adding a 2D survey map

We will insert a digital image of a survey 
map into the Revit Site Model file, supply-
ing a base for us to work up the existing 3D 
site elements.

To Insert images into a View in Revit, the 
image must be available in a supported im-
age file format, for example JPG, PGN or 
even PDF.

Preparation
Go to BIMbogen.dk in a web 
browser and download Re-
vit_Case_Study_SITE_SUR-
VEY_IMAGE.
Unzip to the Revit Case Study 
project folder on your computer 
(created in chapter 1.2).

Next, start up a new project as  
described on page 117. Save 
the project.

1 In Revit, go to the Project 
Browser and activate the Site 
View by double-clicking it.
Zoom out to get a good over-
view.

Insert Image

2 In the tab Insert, click on Im-
age to start inserting an image.

Browse to the project folder 
and select the site survey im-
age file.
Click Open.

Insert Image

2
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3 Place the image to the right 
of the Project Base Point. 
After the command is started, 
you can still navigate (Zoom or 
Pan) before placing the image.

Scale Image
The image must be scaled to 
the right size. We will do this 
manually by using the ruler dis-
played on the image.
Click to Select the image. 

4 In the Contextual Modify tab, 
start the Scale command. 

5 Zoom in closer on the ruler. 

4

3

Scale

5
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Scale Image (continued)

6 Click at first reference point  
(origin) on the scale bar.

Drag the cursor to the second 
reference point (the drag point) 
on the scale bar (navigate - 
Zoom or Pan - if necessary to 
get there).

7 Click on the second point of 
reference. Zoom out again to 
see the ruler. Type the exact 
desired length between the 
two points of reference - in this 
case 50.000 (50 meter) - and 
press ENTER.

Through the whole routine, be 
very exact in order to scale the 
image as precise as possible.

For further advice on com-
plex routines like this, see Tip 
above.

8 To check that the scale is 
correct, go to Quick Access 
Toolbar and start command 
Measure. Click on both ends 
of the scale and read the dis-
tance. Make sure that is very 
close to 50.000 mm. If not, redo 
the scaling routine.

6

Complex routines in Revit
Some commands in Revit involve many clicks 
from starting the command until finishing it (most 
often by pressing Escape twice). Often, one single 
mistake will cause the whole routine to fail or not 
come out the expected way.
A few good advice when carrying out complex rou-
tines:

Watch the Status Bar (see figure A.1.4 and Insert 
1/ Revit User Interface in the back of Volume I). 
This is where Revit asks for step-by-step input at 
any given time - unless an object is selected.
In order to see which next step Revit expects from 
you, it is sometimes necessary to move the cursor 
to a blank spot in the Drawing Area.

When clicking in the Drawing Area, pay attention! 
The moment you click, Revit often gives valuable 
information on snap locations or directions.

If a command seems to go wrong, press Escape 
TWICE to abort the command (Please note: This 
will NOT finish Editing Mode).

If an unsuccessful command causes faults in the 
model, Undo the command.

Search Revit Help on a specific command by 
pressing F1 while hovering the cursor (not click-
ing) above the command button.

Figure A.1.4
The Status Bar asking for input

8

7
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PROCEDURE/ Drawing the Property Boundary

Sketch Property Line 

1 To draw the boundary of the 
property, go to the tab Mass-
ing and Site and start the 
Property Line command.

2 Select Create by sketching. 
You are now in Edit Sketch 
Mode and can use the drawing 
tools normally available here.

3 Draw the Property Line us-
ing the Line Tool. Try to be very 
exact.

Start in the top left corner and 
draw clockwise.

4 Assuming that the two east-
ern corners are right-angled, 
look for the snap icon Perpen-
dicular and Extension before 
clicking to finish the second 
and third line.
Finish the last line by snapping 
to the first point of the first line.

5 Click Finish Edit Mode in 
tab Modify... the Property Line 
is now finished.

Area check

6 Select the Property Line. In 
Properties, observe the Area. 
The area should be very close 
to 1400 m². If it’s not, try again 
to Scale the image and sketch 
the Property Line.

3

4

5

Property Line

Property Boundary

6

1
2
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4

Preparations
Go to Plan View Site.

1 In the View Control Bar, set 
Visual Style to Wireframe.

2 In the Annotate tab, start 
the Detail Line command.

3 In the Draw tools, pick Rect-
angle.
By clicking twice, draw a rect-
angle following the edges of 
the survey plan (see Figure 
A.2.2). This rectangle is only a 
2D serving as a frame for the 
terrain we will create.
End the command.

Create Toposurface

4 Go to tab Massing & Site. 
Start command Toposurface. 
Revit is now in Edit Mode and  
command Place Point is acti-
vated.

Detail Line

Place Point

Toposurface

PROCEDURE/ Modeling the terrain

Now that reliable 2D information is estab-
lished, it is time to model a 3D site based 
on the 2D underlay.
We continue using tools from the tab 
Massing and Site.

2

1

Figure A.2.2
Drawing a Detail Line to set the limits of terrain

3

SITE 3D/ Model the topography
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6

7

Toposurface
In Revit, terrain is modeled as a Toposurface 
- a surface defined by any number of points in 
three-dimensional space. Between the points, 
Revit interpolates to generate a relatively 
smooth surface.

A Toposurface can be created by working in Site 
View, plotting points with different Z-coordinates 
on top of a 2D underlay.

The points defining the edges of the Toposur-
face are called Boundary Points by Revit - the 
rest are Interior Points.

Other means of aquiring 3D topographic exist. 
For example, digital information can be import-
ed from digital surveying instruments, or linked 
into the site model from another CAD file with 
topographic 3D information. - see also section 
A.1.

5 Zoom to the top left corner of 
the survey plan. The elevation 
of the first contour line is shown 
to be 42,50 meters (above sea 
level).
With the Place Point com-
mand still active, go to the Op-
tions Bar and type 42500 in 
the Elevation field.

6 Plot points on top of the con-
tour line by clicking along the 
line. Try to keep an even dis-
tance between the points. Start 
and end the contour line with 

points placed exactly on the 
edge of the drawing by snap-
ping to the rectangle framing 
the survey drawing.

7 Before starting to plot points 
on top of the next contour line, 
remember to adjust the eleva-
tion in the Options Bar. This 
should be set to 43000 for the 
next contour line.

8 Draw a couple of contour 
lines more using the same 

method. Notice that Revit au-
tomatically generates contour 
lines.

9 Also, notice the edge of the 
Toposurface being generated 
as you add points.

Place points along the rest of 
the contour lines.
Press ESC to end the Place 
Point command.

5

8

9
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13

Edit Points

10 A point in a Toposurface is 
an object like any other object 
in Revit. Like other objects, it 
can be edited at any stage.

If a number of points by acci-
dent is set to a wrong eleva-
tion, Select the points...

11 ... and change the eleva-
tion by typing the correct val-
ue in the field in either Option 
Bar...

12 ... or in Properties.

13 When all points are set in 
the correct position with the 
right elevation, go to tab Mod-
ify... and click the green tick to 
end Edit Mode.

Set Visual Style back to Hid-
den Line.

11

12

10
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Review Model
Go to the View (3D).

14 in Properties, check Sec-
tion Box.

15 Select the Section Box 
and drag the Controls towards 
the center to cut off the edges 
of the terrain. Notice that the 
Toposurface becomes solid, 
making it easier to see the 
slopes of the terrain.

After checking the terrain, 
switch off the Section Box 
again.

Figure A.2.3
Terrain model i the 3D View

14

15
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3

5

6

4

Create Subregion
Go to Plan View Site.

1 Go to the tab Massing & 
Site and start the Subregion 
command to start drawing one 
Subregion for the road and 
both sidewalks.

2 Using the Line tool, draw a 
line on top of the eastern Site 

Boundary, snapping to its ends. 

3 Select the line, grab its lower 
blue handle and drag down-
wards snapping to Original un-
til it is approx. 34000 mm long.

4 Still in Edit Mode, go to tab 
Modify... and start command 
Tangent End Arc.

5 Click and snap to the low-
er end of the first line drawn 
to start arc here. Drag down-
wards, controlling the arc to fol-
low the curve of the sidewalk.

6 Click here to finish line. 
Press ESCAPE twice - first 
time ends drawing a continu-
ous arc, second time ends the 
command.

PROCEDURE/ Subregions

Subregions

To show roads, sidewalks, paved areas or 
other differences in surfaces within a Topo-
surface, we use the tool Subregion to sub-
divide the Toposurface. 
A Subregion forms part of a Toposurface, 
but can be assigned its own properties, dif-
fering from the rest of the Toposurface.

The extents of a Subregion are defined in 
Edit Mode using the drawing tools normally 
available here.

In this case study, we will use the tool to 
create the road and the sidewalk.

2

1

Subregion

Line - Tangent 
End Arc
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7 Go to tab Modify... and start 
command Offset. In Options 
Bar, set Offset to 8000. Offset 
the line and the arc towards 
right by clicking near the right 
side of the two lines.
Press ESC to end  the com-
mand.

8 Draw two lines above and 
below the road well beyond the 
edges of the Toposurface.

9 Start command Trim/ex-
tend to corner. Use it to form 
a closed figure. Remember to 
click on the parts of the lines 
to retain. End the command 
(ESC).

10  The group of lines must be 
a closed loop.

11 Click Finish Edit Mode to  
end road Subregion.

Edit Mode
The geometry of certain Revit Family Types, e.g. 
Roofs, Floors, Toposurfaces and Subregions, 
can be modified in Edit Mode.
Edit Mode is entered through command ‘Edit...’  
found in context-specific part of tab Modify... The 
only way to exit Edit Mode is clicking the red cross 
(abort) or green tick (save changes).

In Edit Mode, many command buttons turn gray, 
indicating that these cannot be used. Also, all other 
objects than the one being edited turn gray - these 
cannot be selected or modified while in Edit Mode.
Most basic Drawing Tools and Modify Tools are 
always available in Edit Mode and are used in the 
same way, regardless of the Type of element being 
edited.

Offset

Trim/ Extend to 
Corner

7

8

8

7

109

9 11 12
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Pick Lines

Phase

Figure A.3.1
Boundary Lines of Subregion for property

After creating the topography, the bound-
aries and some subregions following the 
method of either section A.1 or A.2, the 
final parts are managed in the same way 
regardless of the previous.

Apart from topography, other 3D informa-
tion may be relevant to add to a building 
model at a concept design stage - location 
of existing buildings, bodies of water etc.

Site Subregion
Create a new Subregion follow-
ing the site boundary as shown 
in Figure A.3.1.
Start the Subregion command.

1 Use the Pick Lines tool and 
pick the four Property Lines. 
Finish Edit Mode.

Subregion Materials
Subregions can have different 
materials applied e.g. grass, 
asphalt etc.
See Appendix B: Presentation 
for detailed information on how 
to apply different materials to 
different subregions.

Topography Phase

2 By default, the Phase of all 
new elements is set to New 
Construction.
The Toposurface created in the 
previous is the existing terrain. 
Therefore, set the Phase Cre-
ated to Existing.

PROCEDURE/ Finalizing the existing site

A.3/ FINALIZE THE EXISTING SITE

1

2
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5

Planting

Figure A.3.2
Rotating a tree

3

4

Place Trees

3 In the tab Massing & Site, 
start the Site Component 
command.

4 In the Type Selector, pick a 
tree (e.g. Red Ash - 7.6 Me-
ters). In Properties, set Offset 
to -200.
Place one tree in the model by 
clicking. Press Escape twice.

Rotate Trees
Select the tree.

5 In the tab Modify..., start the 
Rotate command. Rotate the 
tree to an uneven angle (e.g. 
35 degrees - see Figure A.3.2). 
Being seen at an oblique angle, 
the tree will look more random 
and thus more ‘natural’ when 
generating facade output.

Plantation

Studying the survey plan, we will find that 
in our case the only available information 
about the site which has still not been add-
ed to the model is Plantation.

The aim of showing existing plantation in 
the model at this stage is mainly to be able 
to estimate the visual impact of the build-
ing in the landscape. Therefore, we do 
not need to aim at a high level of realism, 
but just at getting the overall appearance 
roughly right.

We assume to have some knowledge of 
the plantation from a visit on site:
All trees are deciduous and the remains of 
windbreaks. The trees along the northern 
boundary are free-standing 8-12 meters 
tall, and the plantation in the south eastern 
corner is a thicket 5-7 meters tall.
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8

Add Trees

6 With the tree still Selected, 
start the Copy command.

7 In  the Options Bar, tick 
Multiple.

8 Copy the tree to the other lo-
cations along the northern site 
boundary.

Insert trees in the south east-
ern corner in a similar manner. 
Use for example Type Haw-
thorn - 7.4 Meters.
To adjust the height of the 
trees: Select one of them. In 
Properties, select Edit Type. 

9 Go to field Height and type 
5500, overwriting the previous 
value.

Hide Survey image
We do not need the survey im-
age any more at this stage, but 
we want to keep it in the model, 
so we hide it.
Select the image. Right-click, 
go to Hide in View and pick 
Elements.

6

7

9
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Adjust Trees 
Go to the View North Elevation. 
We could now try to make the 
trees look less alike and more 
natural. Here is five ways to 
achieve this:

10 Rotating trees: In Plan 
View Site, Rotate some trees 
to a slightly different angle (see 
figure A.3.3).

11 Resizing trees: Select a 
tree. In Properties, click Edit 
Type. Click Duplicate and give 
the new type an appropriate 
name. Click OK.
In Type Properties, change 
Height to a new value.
Click OK > OK.

12 Mirroring trees: In View 
North Elevation, Select another 
tree. In tab Modify..., start the 
command Mirror - Pick Axis. 

In Options Bar, uncheck Copy.
Mirror a the tree by clicking the 
vertical axis. Press Escape.

13 Changing tree Type: In 
Type Selector, select another 
Type. If necessary, Edit Type > 
Duplicate and change Height.

Making Plantation partially 
Transparent (see chapter 3.3).

11

12

10

13

Figure A.3.3
Variation in how trees appear more natural
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PRESENTATION
2D drawings, whether printed or digital 
(PDFs), is not the only media format of-
fered by Revit for presenting a building 
project.

Before deciding which media to use for 
the presentation of your project, it is 
relevant to consider the recipient of the 
presentation and in which context the 
presentation will be seen.

If the building is presented in a news-
paper or in a brochure, a still picture 
is an obvious choice. If the choice of 
materials is not yet in place, a black/ 
white picture may be the best option. 
For non-professional recipients and for 
selling or otherwise convincing, photo-
realistic rendered perspectives may be 
considered.

If the building is presented on a web 
page or at a live event, opportunities 
are much wider.
Video walkthroughs and interactive 
panoramas as known from at real es-
tate websites can be generated in Revit.

Working with the presentation formats 
presented in this appendix, you can de-
cide to continue working on your cur-
rent Revit Model, or you can download 
a sample file from www.bimbogen.dk.

Figure 8.1.1
Presentation media in-
troduced in Appendix B

2. Still Renderings

1. Still Shadings

3. Movie Walkthroughs

4. Interactive Panoramas

B
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This example of an exploded View shows 
the kitchen with the different elements 
dragged apart for better overview: plinth, 
casework and counter-top. The presen-
tation will be without colors (Visual Style: 
Hidden)

OVERVIEW/  Still - Exploded View

•	 Create new 3D View...
•	 ... or use existing 3D View
•	 Adjust Graphic Display
•	 Move objects; Display Elements
•	 Lock 3D View
•	 Add Text
•	 Print or export

B.1/ STILL - EXPLODED VIEW
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Create an exploded view

PROCEDURE/ Creating an exploded view

Download
In a web browser, go to www.
bimbogen.dk and download 
the file Revit_Case_Study_MA-
TERIALS.zip. Save it to the 
Revit Case Study folder and 
unpack the file here. 
In the folder you’ll find a Sam-
ple file; Revit_Case_Study_
Building_Final.rvt. You can 
choose to continue working on 
your own Revit file or use the 
Sample. 

Review model
In the Project Browser, go to 
the View 3D Section Kitchen.

1 On the ViewCube click the 
Right/Back/Top corner.

2 To avoid rotating the view 
later on, click Save Orienta-
tion and Lock View.

Displace Elements

3 Select the four Cabinets. 
Click Displace Elements.

4 Move the four Cabinets up 
by dragging the blue arrow i the 
Z-direction.

5 In Properties you can enter 
a specific height by changing 
the Z Displacement. Set the 
value to 2400.
Move the Counter Top using 
the same method; Z Displace-
ment; 3600.

Displace Elements

1

2

3

5

4
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6

9

Create Paths

6 To show the objects original 
position, you can create Pro-
jection Lines. Select the four 
Cabinets and click Path. Click 
on the edges to make the Pro-
jection Lines.

Make the same procedure on 
the Counter Top.

Adjust View 

7 Set the View Scale to 1:50.

8 Go to Tab Annotate, click 
Text and Pick One Segment.

9 Add text to the view.
Turn on Crop, adjust it, and 
hide it again.

Displacement Set 

Path

6

7

8
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Sketchy Lines (Optional)

1

12

Enable Sketchy Lines

1 Select Edit Graphic Dis-
play Options.

2 Enable Sketchy Lines and 
move the Jitter slider to indi-
cate the degree of variability in 
the lines.
Extension indicates how far a 
model line’s endpoints extend 
beyond intersections.

Sketchy Lines

PROCEDURE/ Creating Sketchy Lines

the Graphic Display Option Sketchy Lines 
emulate a hand drawing, which can serve 
to lend an less ‘literal’ air to a drawing than 

a more exact presentation style. Sketchy 
Lines can be applied for any View (except 
Ray trace).
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A still rendering is an image generated from 
the model, where shadows, reflections etc. 
are calculated by the software with a high 
degree of detail in order to achieve an out-
put with photorealistic qualities.

Rendering an image may take a lot of time 
for the computer, depending on the level of 
detail of the image and the computer hard-
ware properties.
Therefore, it is often a good idea to gener-
ate initial low-quality renderings with a low 
degree of precision - or showing only a part 
of the image - in order to test the settings 
before starting the final render command.

OVERVIEW/  Still - Rendering

•	 Set up Materials
•	 Apply Materials to Surfaces
•	 Create new 3D Camera View or 

Duplicate existing Camera
•	 Adjust Render Quality
•	 Render on local computer or 

Render in Cloud

B.2/ STILL - RENDERING
Figure B.2.1
Stages of the development creating Renderings in 
Chapter B.2

1. Creating Material Database

3. Rendering the Scene

2. Adding Materials to surfaces
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The Material Browser

PROCEDURE/ Material Browser
Material Browser

1 Go to the Tab Manage and 
click Materials to open the Ma-
terial Browser.

2 You see a list of the Materi-
als already in the scene.

3 You also see the list of Au-
todesk Standard Material, 
(click black triangle at Home to 

unfold) which is premade Ma-
terials that can be applied to 
the Materials in the scene.

4 Select Brick, Common.

5 Identity Tab is general infor-
mation about selected materi-
al; class of selected material 
(Masonry) Name etc. 

Assets

6 Assets of the selected ma-
terial; Graphics, Appearance, 
Physical and Thermal.
Graphic and Appearance As-
sets will be explained on the 
next pages.
Physical and Thermal Assets 
will not be introduced in this 
book.

2

4

3

65

Some basics of setting up Materials has 
already been introduced in chapter 5.
In this section, the Material Browser will be 
explained in greater detail.
The Material Browser displays all Materi-
als in the project, whether they are used by 
objects or not. It also offers the opportunity 

to load Materials from other Libraries into 
the project.
Material Libraries are files which the exten-
sion .ADSKLIB.

Material Browser

1
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Material Setup

1 Click Create New Material.

2 On the Identity Tab name 
the new floor material; Flooring 
Wood Exterior.

3 Set the Class to Wood. 

4 On the Graphics Tab, en-
able Use Render Appear-
ance. Revit calculates an aver-
age color of the image applied 
in the Appearance tab used 
for the Visual Styles Shaded 
and Shaded With Edges.

Add photo for rendering

5 On the Appearance Tab, 
click the white area to add an 
image. Browse the MATERI-
ALS folder and select Wood_
Terrace_boards_1450x5400.
jpg

Create a new Material

1

2

3

5

PROCEDURE/ Creating a new floor material

4

A Material can be created from sketch as 
shown in this procedure.
This method is used, if no Material with  

similar properties is available in the Materi-
al Browser, or if full control of many Materi-
al Parameters in detail is needed. 
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6

7

10

11

Texture Editor

6 Set the Glossiness value to 
0 (no glossiness)

7 Click on the image to start 
the Texture Editor.

8 Uncheck the Scale Lock of 
the image.

9 Set the Sample Size 5400 
and 1450 (WxH).
Click Done to finish Texture 
Editor and return to the Mate-
rial Browser.

Texture Editor 

10 Right-click on the new ma-
terial and make it into a Favor-
ite.

11 The material is now also  
stored in the Favorites Li-
brary.

9

8

Texture Editor
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6

3

7

4

5

Material overview

1 Right-click on the material 
Brick, Common and Duplicate 
the material and it’s Assets. 

2 Go to the Tab Identity and 
name the new brick material 
Brick D72. You can add in-
formation about Manufacturer 
and URL if you like.

3 Go to the Appearance Tab.  
Take a look at the most import-
ant settings: 

4 Masonry is a real picture of 
a tileable brick wall.

5 Relief Pattern create a sim-
ulation of a recessed joint. Re-
lief Pattern is a black & white 
copy of the Masonry image.

Shared Material

6 Note that this asset is shared 
with another material (Brick, 
Common). If the material is 
modified, the other material will 
also be modified. 

7 To make material Brick D72 
unique, click Duplicate This 
Asset.

Duplicate Material

Duplicate an existing Material

PROCEDURE/ Duplicating existing Material

2

1

Another method to generate a new Mate-
rial is to duplicate a similar Material and 
change change its Parameters as needed.
This method is often quicker than the previ-

ous method and is especially useful, when 
it is not of great importance to get all Mate-
rial Parameters exactly right.
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8

9

11

12

13

10

8 The asset is now only used 
by this material.

Change Texture Image

9 Choose a new image for  Ma-
sonry: Click below the image 
preview and choose a new tex-
ture. Browse the MATERIALS 
folder and select Brick_D72_
Petersentegl_3120x2000.jpg. 

Texture Editor

10 In the Texture Editor,  set 
Brightness to 100. 

11 Unlock the aspect ratio 
and set the Scale to 3120 and 
2000 (WxH).

12 Enable Link texture 
Transform. This will bind the 
Transform settings together 

for both  Masonry & Relief Pat-
tern. Click Done to finish.

13 Select a new image for 
Relief Pattern; Brick_D72_Pe-
tersentegl_3120x2000_BUMP.
jpg. Set the scale and enable 
Link texture Transform.
Click Done to return to the Ma-
terial Browser and make also 
this material to a Favorit.
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Create new Material II

1 Select Default Wall material 
in the Material Browser.

2 Open the Asset Browser.

3 Expand Appearance Li-
brary to view list of Appear-
ance Assets.

4 Select Wall Paint/Matte Li-
brary.

5 Select White and click Re-
place the current asset. The 
Default Wall material now have 
a white Painted Matte Color.
Close the Asset Browser to 
return to the Material Browser.

Add Predefined Assets to Materials

1

2

4

3

5

PROCEDURE/ Adding predefined Assets to Materials

Now we have created two very important 
material to the project for a good exterior 
rendering: Brick and the terrace flooring.
We will now edit other Materials by ex-
changing their current Appearance Assets 
with Assets from the Library that came with 
the Revit installation.

Material Library
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10

7

9

9

6
8

Create new Material III

6 Create a new material called 
Sitework Pavers. Replace the 
Appearance asset with Pavers 
- Square Gray-Brown from the 
Sitework category.

7 Scale both images (also 
Bump) to 2000x2000.

8 Set Image Fade to 50 and 
set color to a light gray color. 
This will tone the pavers to a 
lighter material.

9 Complete the material list 
with materials on your own 
choice or open Material Library 
BIMbogen.adsklib which is a 
library file containing premade 
Materials. 

10 You can return and add 
more materials later on in the 
process. For inspiration check 
out BIMbogen’s list of materi-
als.
Click OK to close down the Ma-
terial Browser.
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Apply By Category

1 Open the View 3D Section 
and set the Visual Style to 
Consistent Colors. 

2 In Tab Manage, click on 
Object Style. Without having 
noticed it, you have already 
changed the material for Walls.

3 Select Walls. You see that 
the material applied for Walls 
is the material Default Wall. 
Click in       to open the Materi-
al Browser.

4 Select the Appearance Tab 
and see that Default Wall is 
the white paint matte materi-
al you made earlier. Click OK 

and close down both Material 
Browser and Object Styles.

Review model 
Take a look at the building. A 
question might pop up: Why is 
the Exterior wall not completely 
white? 

Object Styles

Visual Style:
Consistent Colors

Add Materials to surfaces

4

3

PROCEDURE/ Adding material to elements

We have now created the Materials need-
ed for generating visually detailed output. 
Now these materials need to be added to 
surfaces in the model. This can be done in 
several ways:

1.	 By Category. Add the same material to 
a whole Category (all walls, roofs etc)

2.	 By Layer. Add the material to a surface 
layer of the element in the Type Prop-
erties.

3.	 By Face. Add the material by Painting 
a face of an object if none of the above 
procedures are possible.

2

1
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5

6

Apply By Layer

5 Select a random exterior 
Wall and click Edit Type.

6 Click Edit Structure. The 
Interior side is set to material 
By Category (Default Wall) and 
the Exterior side is set to ma-
terial Brick Common. Click on 
Brick Common to open Materi-
al Browser.

7 Select Brick D72 as the new 
material. Click OK to finish.

Review model
Check the Model and see how 
Materials is applied to most ob-
jects. Material Brick Common 
is still visible on some faces.

5

7

Figure B.2.2
3D View of the Building Model in Visual Style Con-
sistent Color with material applied to Walls
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Review model

8 Set the Visual Style to Re-
alistic. Changes made before 
in the Material Browser’s Ap-
pearance Tab, are visible in the 
view.
 
Apply By Face 
Select the garden Wall.

9 In the Modify Tab, click on 
Paint tool.

10 Select Brick D72 and Paint 
all remaining faces e.g. the top 
of the garden wall. See Figure 
B.2.3.

Complete Materials
Now work through all Cate-
gories, Object’s and faces to 
apply materials correctly to all 
objects:

Step 1
Start applying material using 
Object Styles to as many cat-
egories as possible. Note that 
if you open the hierarchy of for 

example Roofs, you can apply 
different materials to subcate-
gories.
Set the Visual Style to Realistic 
and see how the materials ap-
pear realistic in the model.

Step 2
Apply materials by Type or In-
stance. 

Step 3
If necessary, use paint to apply 
final materials to object faces.

Visual Style; Realistic

Paint

9

10

Figure B.2.3
3D View of the Building Model in Visual Style 
Realistic with material applied to Walls

8
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Rendering

Day scene render
To render is to simulate reality based on 
physically accurate lights, materials, and 
light reflection.
This first rendering will be a day time ren-
dering. The scene will be lit by the sun only.

Figure B.2.4
Rendering of a day scene

PROCEDURE/ Rendering a day scene
View Setup

1 Duplicate an existing 3D 
Camera View or create a new 
camera Name it; Rendering 
Day Exterior South-West.

2 Disable the View Template 
(None). 

3 Open the Rendering Dia-
log.

1

3

2
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4

5

Background Image

Sun Settings

7

8

6

Render Settings 

4 Set the Quality Setting to 
Medium.

5 Set the Resolution to Printer 
& 150 DPI. The output will be-
come a 400x229 mm. picture 
printed in a 150 DPI quality or 
a 2362x1350 pixel picture. 

6 Leave the Lighting Scheme 
to Exterior: Sun Only. The 
scene will only be lit by the sun 
(not artificial light). 

Click to edit Sun Settings. 
Set the location to Aarhus, 01 
June 1400. 

7 Select Style > Image and 
click Customize Image to en-
ter Background Image. 

8 Click Image to browse a 
picture on your computer. In 
your MATERIALS folder you 
can find an example called 
Sky_and_Field.jpg. Click OK 
to finish.

7
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13

11

14 15

Render 

9 Click Render. Quality set-
ting, computer power, and 
material settings will have in-
fluence on how long it will take 
to render the photorealistic pic-
ture.

Work flow 

10 A good rendering work 
flow is to render a smaller Re-
gion before rendering the final 

picture. The Region should in-
clude both areas lit by the sun 
and shaded areas.

11 The Region can be resized 
and moved around the scene.

12 If you have a limited 
amount of time for your render-
ing, in the Quality settings, you 
can choose Edit and set the 
Render Duration to Render by 
Time.

Post production 

13 After the rendering is fin-
ish, you can adjust the Expo-
sure of the picture. 

14 You can Save Picture to 
Project. The picture will be 
stored as a view in the Project 
Browser. Note that the render-
ing will NOT be saved if you go 
to another view.

15 Export will save the file to 
the computer as an image.

Render

Render by Time

9

10

12
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View Setup 
Duplicate Rendering Day Ex-
terior South-West and rename 
to; Rendering Night Ext...

1 Go to Level 0. Set the Dis-
cipline to Electrical. This will 
make the Lighting Fixtures vis-
ible. Check that the Top View 
Range is set to minimum 2500.

Artificial Lighting Setup

2 Go to the Tab Systems and 
select Lighting Fixtures.

3 Place two M_Studio Lights 
in the room. The placement 
height of the Light above Level 
0, is by default 2400 mm.

4 If you want to adjust this 
height, enter an Offset value. 
Place 10 - 12 Lighting Fixtures 
on Level 0 and 1 and 4 - 6 
Lighting Fixtures in the rooms 
on Level 2. See Figure B.2.5.

Rendering

Discipline

Lighting Fixtures

Night scene render

1

2 3

4

PROCEDURE/ Rendering a night scene

Second rendering will be at night time. The 
scene will be illuminated by artificial lights only. 
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5

5 Select a Lighting Fixture and 
click Edit Type to adjust the 
height of all M_Studio Lights. 
Among other settings, you can 
adjust the Initial Intensity & 
the Color of the light. Make a 
change if you like.

Render Settings 

6 Open the Rendering Dialog 
and set Lighting Scheme to 
Exterior Artificial Only (Lighting 
Fixtures)

7 Change the Background 
Image to Night_background.
jpg. 

Artificial Lights

Figure B.2.5
Lighting Fixtures placed in the Scene

6

7
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Render Picture 

8 Open the Rendering Dialog 
and adjust settings. Hit Ren-
der.

Adjust Rendering

9 If the rendering turns out to 
be very dark, don’t be disap-

pointed. Click Adjust Expo-
sure.

10 Try adjusting the Expo-
sure value to brightened up 
the scene.

11 Click OK to see the chang-
es on the picture.

12 You can always press 
Reset to Default to start over 
again.

Save Rendering 

13 Click Save to Project.

14 The rendering will be visi-
ble in the Project Browser.

Exposure Control

8

9

13

10

11

14

12
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Export images

1

2

3

4

6

7

5

Export Setup

1 Go to Application Menu 
(Blue Revit icon) - Export - 
Images and Animations and 
choose Image.

2 Click Current Window if you 
only want to export this view.

3 Or choose Selected view/
sheets if multiple views should 
be exported.

4 Select the views or sheets to 
be exported.

5 Choose a Destination.

6 Set the Pixel Size.

Export

7 Choose a format and click 
OK.

Export Image

PROCEDURE/ Output: Export images

To use a rendering or a View (floor plan, 
section, elevation etc.) outside the Project 
File - as an image in a document, digital 
presentation or on a website, it must be Ex-
ported from the project. 

The Export dialogue box is very similar to 
the Print dialogue box in Chapter 3.
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A Walkthrough is an animation of the 
Model - a movie filmed through a virtual 
camera in motion through the Model.
The Walkthrough consists of a series of 
camera positions on a Path. When gen-
erating the walkthrough, the camera is 
moved from one position to the next in one 
smoothly flowing movement.

OVERVIEW/  Movie - Walkthrough

•	 Create Walkthrough Camera
•	 Draw path for camera
•	 Adjust path and camera
•	 Export 

B.3/ MOVIE - WALKTHROUGH

Figure B.3.1
Stages of the development creating a Walkthrough in 
Chapter 8.2.

1. Create Path

3. Export

2. Adjust Path
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Arrange Views for overview

PROCEDURE/ Arranging Views for overview

Arrange Views 

1 Go to the Floor Plan Site. On 
the View Tab click Close Hid-
den. This will leave you with 
only Site View open.

2 Open the two Elevations; 
Elevation 1 & 2 and click Tile 
on the View Tab. All three open 
Windows will be placed be-
sides each other and not on 
top.

3 That will give a good over-
view of the creation of a Walk-
through.

As you may have experienced throughout 
the book, setting up Views for an optimal 
overview is the key to a good work flow.
This also applies when the path and cam-
eras are adjusted in this walkthrough.

1 2

3

Close Hidden

Tile Windows
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Model overview

1 Go to Site and Maximize the 
view. Select the Visual Style; 
Wireframe so that you can see 
through the model.

Create Walkthrough Path

2 Go to the Tab View and start 
the Walkthrough command  
on the 3D View menu.

3 Create a path where your 
camera will fly along. Click to 
place the first key frame for 
your path.

4 You can set the height of the 
camera by adjusting the offset 
value before you place a new 
key frame.

5 When you have placed the 
last key frame click Finish 
Walkthrough.

Arrange Views

6 Open the Walkthrough Cam-
era and click Tile on the View 
Tab to have Site, Elevation 1 
& 2 and Walkthrough Camera 
open and visible at the same 
time.

Walkthrough

Animated walkthrough

1

2

3

PROCEDURE/ Creating an animated walkthrough

5

6

4
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7

8

10

9

11

Adjust Walkthrough

7 Select the Walkthrough 1 
View. Click Size Crop.

8 Set the Model Crop Size to 
200 mm. & 140 mm. and click 
OK.

9 Click to setup Graphic Dis-
play Options manually. 

10 Disable Far Clip Active 
(Infinite visibility)

11 Select Walkthrough 
Frames.

12 Adjust the Total Frames 
to 400 and the Frames Per 
Second to 20. The Camera 
will move slower. Enable Uni-
form Speed to individually ad-
just Accelerators between Key 
Frames.
Click OK to finish.

12

Frames

Uniform Speed
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15

19

18
16

17

17

Edit Walkthrough

13 When you deselect the 
Walkthrough Camera, it will 
be invisible. Right-click on 
Walkthrough 1 in the Project 
Browser and click on Show 
Camera. 

14 Click Edit Walkthrough in 
the menu.

15 Click Play to see the walk-
through before we adjust the 
path & camera.

16 Reset camera back to Key 
Frame 1; type 1 and ENTER.

Adjust Camera

17 Move the Cameras Target 
Point on the Site plan or on a 
Elevation.

18 Click Next Key Frame. Ad-
just Camera Target etc. etc.

Adjust Path 

19 At every Key Frame you 
can also choose to control the 
Path instead. Move the Path 
on a Site View or on an Eleva-
tion View.

Final Adjustment
Try playing the movie and edit 
the path and adjust the camera 
until you think it’s perfect.

Edit Walkthrough

13 14
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20

21

Export Setup

20 Go to Application Menu 
(Blue Revit icon) - Export - 
Images and Animations and 
choose Walkthrough.

21 Be realistic when you set 
the Visual Style and Dimen-
sion. Rendering this movie can 
take weeks instead of hours if 
you choose Realistic!. Try us-
ing the Visual Style Shaded 
With Edges and a Dimension 
of 1200 x 840.
Save the movie (.avi) to the 
computer.

Export Walkthrough
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An Interactive Panorama is the output of 
a 360 degree camera in a fixed position 
for digital presentation only. When viewing 
an Interactive Panorama on a computer 
or other device, the view direction can be 
controlled by the viewer, while the position 
of the camera remains fixed. 
Interactive panorama is a service only 
available on the Autodesk 360 Cloud ser-
vice. 
Use the Cloud Render for rendering fast 
Still images and Illuminance studies with-
out using your own computer.

OVERVIEW/  Interactive Panorama
•	 Create new Camera View....
•	 ... or Duplicate existing Camera
•	 Render In Cloud
•	 Show i Web Browser

B.4/ INTERACTIVE PANORAMA

Figure 8.4.1
Screen-shots of the Render in Cloud service
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Interactive Panorama

PROCEDURE/ Creating An Interactive Panorama
Camera Setup

1 Create a new camera view; 
View > 3D View > Camera or 
open Interior Dining.

2 Place the camera so you get 
a nice view into both kitchen 
and living room. Name/rename 
it Panorama Kitchen/Living 
room.

Cloud Setup 

3 Select Render in Cloud.

4 Sign in to your Autodesk 360 
Account if you haven’t already 
done so.

5 Set the Output Type to In-
teractive Panorama and com-
plete other settings; 3D View, 
Render Quality, Image Size & 
Exposure.

6 Click Start Rendering.

7 If the Render In Cloud di-
alog disappear, click Render 
Gallery.

8 After the Rendering is fin-
ished, you can download the 
file and view it in a web brows-
er.

2

1

6

873

4

5

Render in Cloud

Interactive Panorama
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Symbols
3D details  83

3D Views  108–109

A
Add to Set  80

Apertures  72–73

Aquire Coordinates  8

Artificial Lights  159

Assets  150–151

AutoCAD  116

B
Background

Gradient  107
Image  156

BIM  VII

Bind Link  9

Building Model  VII

Building Pad  12–13

C
CAD  VII

Camera  108

Case  VIII–IX

Click  X

Click and drag  X

Close Hidden Windows  163

Component
Component (command)  87

Concept Design  V

Copy  44
Copy to clipboard  72, 79

Curtain Wall  72–73
Curtain Grid  57
Mullion  57

Cut Geometry  84

D
Design Options  79–82

Add to Set  80
Make Primary  81

Detail Line  128

Direction Constraint
Overruling  79

Disallow Join  21

Discipline  158

Disciplines  3

Displace Elements  141

Displacement Set  142

Door  72

Double-click  X

Downpipe  87

Drain Pipe  87

Duplicate Material  148

E
Edit Mode  133

Edit Profile
Edit Roof Profile  45
Edit Wall Profile  62

Edit Walkthrough  166

Elevation (location)
Elevation Coordinates  10
Spot Elevation  105

Elevations (Views)
Output Elevations  106–107

Exploded View  140

Export  118
DWF  112–113
Image  161
Walkthrough  167

Exposure Control  160

F
Fascia  84

Fill Patterns  93–95
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Filters  48–49

Floor  67
Modify Sub Elements  29

Floor Plans  102–103

Foundation  24–26
(Wall command)  24

Frames  165

G
Graded Region  31

Gutter  86

H
Hide View reference  48–49

Host  39

I
Import  118

Information flow  118

Insert Image  124

Interactive Panorama  168–169

J
Join Geometry  26, 68

L
Label Contours  10

Level  17, 65

Lighting Fixtures  158

Link  3, 118

Link CAD  118

Link Revit  3

Location Plan  100–101

M
Make Primary  81

Mass  V

Materials  145
Assets  150
Material Browser  90, 94–95, 145
Material Library  145, 150

Measure  6

Mirror
Mirror - Draw Axis  87

Model In-Place  83–84

Modify Sub Elements (Floor)  29

Move  5–7, 45

Movie  162

Mullion  57

N
New Project  117

North Arrow  100

O
Object-oriented  VII

Object Styles  152

Offset  133

Orientation  8

Overwrite Graphics in View by Element  

51

P
Paint  154

Parameters  VII

Parametric  VII

Paste
Aligned to Current View  72
Aligned to Selected Levels  72, 79

Path  142

Perspective  108–109

Phase  30, 134
Phase Filter  33

Pick Lines  134

Pick New Host  78

Pick Wall  66

Place Point  33, 128

Planting  135–137

Position the building  4–8

Profiles  85

Project  VII

Project Elevation  10

Project File  VII

Project North  8

Property Line  120, 127
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Railing  77–78

Baluster Placement  77
Edit Rail Structure  78
Sketch Path  77–78

Ramp  29

Rectangle  76

Reference Plane
Named  43

Render  157
Render By Time  157
Render in Cloud  169

Rendering  144, 155–160

Reset Profile  55

Right-click  X

Roof  42–46, 69–71
Edit Profile  45, 51
Fascia  84
Fascia: Modify Mitering  84
Gutter  86–87
Pitched Roof  42–46
Roof By Extrusion  43–46

Rotate  4

Rotate True North  8

S
Save As  117

Scale  125–126

Schedules  110

Section
Flip Section  23
Output Section  104–105

Select
Select all Instances  46

Setting the building  2

Set Work Plane  67

Shared Elevation  10

Sheet List  110

Sheets
Sheet Data  101

Site Model  117

Site Settings  11

Site Survey Model  115, 117

Sketchy Lines  143

Sorting/Grouping  111

Specify Coordinates at Point  10

Split Element  20

Split Levels  17–23

Spot Elevation  105

Stairs  38–41, 74–76
Going  41
Landing  76
Riser  41
Run  41, 75
Stair by Component  39, 74
Stair Path  100

Subregion  35, 121, 132–134

Sun Settings  156

Surface Pattern  90
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Tangent End Arc  132

Temporary Hide  59

Temporary Isolate  77

Terrace  27–29

Terrain
Grading  31–33

Texture Editor  147

Thin Lines  69

Toposurface  30, 128–131
Create from Import  119
Place Point  33, 128

Trim/Extend to Corner  133

True North  8
Rotate True North  8
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Underlay  99

Ungroup  9

Uniform Speed  165

Units Format  11

V
View

Close Hidden  163
Output Views  50
Tile Windows  163
View reference Symbol  48
WIP (Work-In-Progress) Views  48

View Template  37

Visibility/Graphic Overrides
Filter  48

Visual Style
Consistent Colors  152
Hidden Line  7
Realistic  154
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W
Walkthrough  164

Edit Walkthrough  166
Export Walkthrough  167
Frames  165
Uniform Speed  165

Wall  68
External Walls  68
Foundation Wall (command)  24
Partition Walls  68
Reset Profile  55

Wall Joins  67

Windows  72

Work Plane
Set Work Plane  67

Z
Zoom to fit  3, 7
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WEBSITE
This present volume is downloaded from the website
Bimbogen.dk

Here, all relevant content is also available for download.

-----------------------------------------------------------------------------------------
To be well prepared for learning Revit at an intermediate level in this 
volume, please first complete all steps in Volume I of this book:

REVIT
BIM and CONCEPT DESIGN
Volume I

- available at book retailers (see bimbogen.dk)
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BIMbogen

LEARN REVIT®

- AND HOW TO MAKE THE BEST USE OF IT
•	 Become a skilled Revit user 
•	 Make sense of BIM - understand and experience the advantages
•	 Learn best practice in modeling with Revit

...all at the same time, using this step-by-step learning guide and refer-
ence book for Revit beginners.

Step 1
(volume I)

Step 3
(volume II)

Step 2
(volume II)

Revit - BIM and Concept Design is a case 
study for students and professionals working 
with building design.

While working your way through the concept 
design stage of a detached single family 
house in a realistic design process, you will 
be led through all the tools in Revit necessary 
to master modeling a small building.

Through the course of this guided tour, the 
project will develop and change - much like 
a real project - as ideas meet the real world.
In this process, the advantages of Revit and 
BIM methods (Building Information Modeling) 
will come alive, enabling you to easily make 
changes to the project.

Applying Revit in a real-world scenario, this 
learning guide sets up a robust model for how 
to actually use and make use of Revit in a 
project in the design stages. Detail and effort 
is balanced, addressing the needs of profes-
sionals as well as students of architecture or 
architectural technology.

Revit - BIM and Concept Design consists of 
two volumes. This present Volume II is availa-
ble only in digital version to download for free 
on BIMbogen’s website. To get the full benefit 
of this volume, please complete all steps of Vol-
ume I (available at book retailers) before start.

The books are structured and layouted to 
serve as not only tutorials, but also as us-
er-friendly reference books on the practical 
use of Revit - to keep and to consult regularly.
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